
 

UNIVERSIDADE FEDERAL DE MINAS GERAIS 

Escola de Engenharia 

Programa de Pós-Graduação em Ciências e Técnicas Nucleares 

 

 

 

 

 

Ester Maria Rodrigues de Andrade 

 

 

 

 

 

DESENVOLVIMENTO DE UM FANTOMA ANTROPOMÓRFICO E 

ANTROPOMÉTRICO FEMININO DE CORPO INTEIRO EM IMPRESSÃO 3D PARA 

CALIBRAÇÃO DE UM SISTEMA CONTADOR DE CORPO INTEIRO 

 

 

 

 

 

 

 

 

 

 

Belo Horizonte 

2024 



Ester Maria Rodrigues de Andrade 

 

 

 

 

 

 

 

 

 

 

DESENVOLVIMENTO DE UM FANTOMA ANTROPOMÓRFICO E 

ANTROPOMÉTRICO FEMININO DE CORPO INTEIRO EM IMPRESSÃO 3D PARA 

CALIBRAÇÃO DE UM SISTEMA CONTADOR DE CORPO INTEIRO 

 

 

 

Dissertação apresentada ao Programa de 
Pós-Graduação em Ciências e Técnicas 
Nucleares da Universidade Federal de 
Minas Gerais como requisito parcial para 
obtenção do grau de Mestre em Ciências e 
Técnicas Nucleares, área de concentração: 
Ciências da Radiação. 
 
Orientadora: Profa. Dra. Telma Cristina 
Ferreira Fonseca 
Coorientadores: Dr. Bruno Melo Mendes 
        Dr. Lucas Paixão 

 

 

 

 

 

 

 

Belo Horizonte 

2024



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                    Andrade, Ester Maria Rodrigues de. 
A553d                 Desenvolvimento de um fantoma antropomórfico e antropométrico     
                    feminino de corpo inteiro em impressão 3D para calibração de um sistema 
                    contador de corpo inteiro [recurso eletrônico] / Ester Maria Rodrigues de . -  
                     Andrade. - 2024. 
                           1 recurso online (132 f. : il., color.) : pdf. 

  

     Orientadora: Telma Cristina Ferreira Fonseca. 
     Coorientadores: Bruno Melo Mendes, Lucas Paixão Reis.     
                                           

                           Dissertação (mestrado) - Universidade Federal de Minas Gerais, 
                      Escola de Engenharia.        
 
                           Apêndices: f. 119-132.               
 
                           Bibliografia: f. 104-117. 
                            

     1. Engenharia nuclear - Teses. 2. Radiação - Dosimetria - Teses.        
3. Impressão 3D - Teses. 4. Detectores nucleares de corpo inteiro - Teses.  
5. Calibração - Teses. 6. Medicina nuclear - Teses. I. Fonseca, Telma 
Cristina Ferreira. II. Mendes, Bruno Melo. III. Reis, Lucas Paixão. IV. 
Universidade Federal de Minas Gerais. Escola de Engenharia. V. Título. 
                                                                                                              

                                                                                                             CDU: 621.039(043) 

        Ficha catalográfica elaborada pelo bibliotecário Reginaldo César Vital dos Santos CRB/6 2165 
Biblioteca Prof. Mário Werneck, Escola de Engenharia da UFMG 

  



 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dedico ao meu marido e à minha família, que 

sempre acreditaram em mim, mesmo quando 

eu não pude.   

  



 

AGRADECIMENTOS 

 

 Ao Programa de Pós-Graduação em Ciências e Técnicas Nucleares do 

Departamento de Engenharia Nuclear da Universidade Federal de Minas Gerais, pelos 

recursos e local de trabalho concedidos. 

 Ao Centro de Desenvolvimento da Tecnologia Nuclear pelo espaço e recursos 

de pesquisa para a realização deste trabalho. 

À Fundação Coordenação de Aperfeiçoamento de Pessoal de Nível Superior 

(CAPES), pela bolsa de mestrado que me possibilitou realizar este estudo.   

À Fundação de Amparo à Pesquisa de Minas Gerais (FAPEMIG) pelo apoio 

financeiro aos projetos APQ-01388-21 da Prof. Telma Fonseca e APQ-0358-18 do 

Prof. Dr. Bruno Mendes.  

Ao Conselho Nacional de Desenvolvimento Científico e Tecnológico (CNPq) 

pelo apoio financeiro ao projeto 40303/2022-3 do grupo de pesquisa do Instituto 

Nacional de Ciência e Tecnologia para Instrumentação Nuclear e Aplicações na 

Indústria e Saúde (INCT/INAIS), o qual essa pesquisa também faz parte.  

Ao Laboratório de Irradiação Gama do CDTN pela irradiação das amostras.  

 Agradeço especialmente à minha orientadora Dra. Telma Fonseca por toda 

ajuda, apoio e sua constante luta por uma ciência justa, de qualidade e colaborativa. 

Obrigada por catapultar carreiras e fazer isso por amor.  

Ao meu coorientador Dr. Bruno Melo Mendes pelo ensinamento, apoio e 

incentivo de sempre. Você é a pessoa e pesquisador no qual vale a pena se 

espelhar e almejar ser parecido. Obrigada por tudo.  

 Ao Dr. Lucas Paixão pela parceria durante toda essa pesquisa, e antes dela 

também. É uma honra publicar juntamente com meu ex-professor de graduação. Se 

estou na pesquisa hoje, você foi um impulsionador. 



 

 Aos meus amigos Bianca Viana e Guilherme Cavalcante, pois passar por todo 

o processo do mestrado sem vocês teria sido muito mais difícil. Vocês sempre são a 

luz no fim do túnel, obrigada! 

 Aos colegas e amigos do grupo de pesquisa Monte Carlo Modeling Expert 

Group (MCMEG) pelo compartilhamento de ideias, resultados, sugestões e apoio. 

Agradecimento especial ao Lucas Araújo pelas simulações computacionais com o 

código TOPAS da gelatina balística. 

 À Hirys Salles, pela ajuda nos passos finais dessa parte da pesquisa. Você 

será uma pesquisadora incrível.  

Aos colegas de pesquisa em dosimetria interna do Laboratório de Dosimetria 

Interna do CDTN. 

 Aos colegas da Seção de Dosimetria das Radiações, especialmente do 

Laboratório de Calibração de Dosímetros do CDTN pela ajuda em todos os 

momentos em que foram necessários.  

  À minha família, pois nesse filme chamado vida, vocês estão nas cenas mais 

importantes, obrigada por tudo. 

 A mim, que permaneceu.  

   

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

“A vida é uma escultura que você molda ao 

cometer erros e aprender com eles.” 

Kim Namjoon



 

RESUMO 

Os Contadores de Corpo Inteiro (CCI) são empregados na dosimetria interna para 

monitoração in vivo. Os procedimentos de calibração de um sistema CCI abrangem 

a medição de um fantoma físico contendo uma fonte radioativa certificada de 

atividade conhecida. Este estudo tem como objetivo a elaboração de um fantoma 

físico antropomórfico e antropométrico feminino, em impressão 3D, para a calibração 

de sistemas CCI, visando à redução das incertezas associadas ao referido sistema. 

O fantoma feminino computacional de referência do ICRP, agora denominado 

RFPID (do inglês, Reference Female Phantom for Internal Dosimetry), foi produzido 

utilizando filamento PLA (do inglês, Polylatic Acid), com interior oco para ser 

preenchido com gel balístico. Embora o gel balístico seja amplamente adotado como 

tecido-equivalente em estudos balísticos, sua caracterização em termos de 

composição química, propriedades físicas e radiológicas, ainda carece de uma 

definição que o certifique como um tecido substituto ideal para dosimetria. Foram 

conduzidos testes no gel balístico para determinar sua densidade e coeficientes de 

atenuação. Este gel foi então comparado com músculo, água, polimetilmetacrilato 

(PMMA) e com os dados dos coeficientes de atenuação do NIST XCOM, com base 

em sua composição. O RFPID foi posteriormente modelado e simulado utilizando o 

código MCNP6.2, preenchido com gel balístico e inserido em um CCI equipado com 

um detector cintilador NaI(Tl) 8”x4” previamente validado. A simulação foi repetida 

utilizando o RCP_AF da ICRP-110 para fins de comparação. Os resultados deste 

estudo indicam que o RFPID, produzido em PLA e preenchido com gel balístico, 

pode ser utilizado como fantoma de calibração para sistemas de contadores de 

corpo inteiro. A validação experimental com o modelo físico é necessária para 

confirmar os resultados quando o simulador estiver preenchido com gel balístico 

contendo fonte de Eu-152. Assim, os trabalhos futuros visam adicionar Eu-152 ao 

gel balístico para preencher os 16 compartimentos do RFPID, possibilitando a 

calibração do CCI do LDI/CDTN/CNEN em Minas Gerais, Brasil. 

Palavras-chave: fantoma de calibração; contador de corpo inteiro; dosimetria 

interna; impressão 3D; gel balístico. 

  



 

ABSTRACT 

 

Whole-body counters (WBCs) are used in internal dosimetry for in vivo monitoring 

bioassays. The calibration processes of a WBC setup include measuring a physical 

phantom filled with a certified radioactive source. The aim of this study was to 

develop an anthropomorphic and anthropometric female physical phantom for 

calibrating WBC systems to reduce associated uncertainties in the system. The 

ICRP's Reference Female Phantom for Internal Dosimetry (RFPID), previously 

referred to as the ICRP female computational phantom, was 3D-printed using PLA 

filament and hollow inside to be filled with ballistic gel. Ballistic gel is widely 

implemented as tissue equivalent for ballistic studies; however, it still lacks 

comprehensive characterization in terms of chemical composition, physical, and 

radiological properties to designate it as an ideal substitute tissue for dosimetry. 

Tests were conducted on the ballistic gel to determine its density and attenuation 

coefficients. The gel was then compared with muscle, water, PMMA, and NIST 

XCOM attenuation coefficient data based on its composition. The RFPID was 

subsequently modeled and simulated using the MCNP6.2 code, filled with ballistic 

gel, and placed in a WBC equipped with a previously validated NaI(Tl) 8”x4” 

scintillator detector. The simulation was repeated using the ICRP-110 RCP_AF for 

comparison purposes. The study findings indicate that the RFPID printed in PLA and 

filled with ballistic gel may serve as a calibration phantom for whole-body counter 

systems. However, experimental validation with the physical model is necessary to 

confirm the results when the simulator is filled with ballistic gel containing an Eu-152 

source. Therefore, future work aims to add Eu-152 to the ballistic gel to fill the 16 

compartments of the RFPID, which will be used for calibrating the LDI/CDTN/CNEN 

WBC in Minas Gerais, Brazil. 

 

Keywords: calibration phantom; whole-body counter; internal dosimetry; 3D-printing; 

ballistic gel. 
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1. INTRODUÇÃO 

O Contador de Corpo Inteiro (CCI) é um sistema de monitoração in vivo de 

dosimetria interna para detecção de exposição interna a fontes radioativas, tanto de 

indivíduos ocupacionalmente expostos (IOE) quanto de indivíduos do público, em 

cenários de monitoramento e/ou acidentes nucleares ou radiológicos (Paquet, 2022; 

Paquet et al., 2015). Para detectar radiação gama proveniente dos radionuclídeos 

internos ao corpo humano, esses sistemas normalmente utilizam principalmente 

detectores do tipo cintiladores podendo ser o iodeto de sódio (NaI(Tl)) ou 

semicondutores por exemplo o de germânio hiper puro (HPGe) (Dantas, 1998; 

Dantas et al., 2011). O CCI, geralmente, compreende em uma sala blindada com 

uma cama ou cadeira para posicionamento do indivíduo, com um ou mais detectores 

de radiação, montados de forma a criar uma geometria de contagem (setup) e uma 

estação de trabalho com um software de aquisição e análises de dados para o 

monitoramento individual. O setup de monitoramento inclui a posição do indivíduo 

em relação do detector e tem um impacto direto nas medições, bem como o 

tamanho (peso e altura) do indivíduo e as características do detector (Bhati et al., 

2012; Fonseca et al., 2014; Fonseca et al., 2014; Mendes et al., 2016). Portanto, a 

calibração adequada dos sistemas de monitoração individual em termo de sua 

eficiência de contagem é de suma importância para garantir medidas mais precisas 

e confiáveis da atividade incorporada ao indivíduo exposto e consequentemente da 

dose efetiva cometida. 

Para a calibração dos sistemas de monitoramento individual, há dois 

principais processos: (1) a calibração em energia que permite reconhecer o 

radionuclídeo pela sua gama característica e o procedimento de (2) calibração em 

eficiência. Este último é tradicionalmente elaborado experimentalmente para 

correlacionar a taxa de contagem registrada pelo detector com uma atividade 

padronizada de um ou mais radionuclídeos incluídos num modelo físico (fantoma) 

antropomórfico de interesse. Estes modelos são muitas vezes desenvolvidos de 

forma a reproduzir um cenário de monitoração levando em consideração os 

aspectos geométricos do setup experimental. Nesse caso, são utilizados com fontes 
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radioativas certificadas de referência contendo atividades conhecidas e distribuídas 

uniformemente dentro do modelo.  

Esses modelos podem ser de corpo inteiro (ANSI, 1999; Kovtun et al., 2000; 

Lebacq et al., 2011; Paiva et al., 2017) ou de partes específicas do corpo como, a 

cabeça, a tireóide ou torso (M. A. López et al., 2019; Manríquez et al., 2016; T. S. 

Moratelli et al., 2021; Snyder & Traub, 2010; Vital et al., 2019; Zeman et al., 2009). 

Embora tais modelos físicos de corpo inteiro cumpram adequadamente a finalidade 

a que se destinam (Ferreira et al., 2023), a sua configuração geométrica desvia-se 

significativamente da anatomia humana do público em geral. Eles consistem 

principalmente em formas cilíndricas, quadradas e retangulares que representam 

cabeça, tórax, abdômen, pelve, coxas, pernas e braços. Portanto, esse fato deve ser 

levado em consideração ao interpretar os dados obtidos no processo de calibração 

quando utilizado esses tipos de fantomas. Os componentes apendiculares do 

BOMAB (do inglês, Bottle Manekin Absorber Phantom), por exemplo, como braços, 

podem causar inconsistências de medição quando posicionados de forma diferente 

a cada medição e seu formato dificilmente pode ser correlacionado ao corpo de um 

indivíduo do público (Bento et al., 2012; Bhati et al., 2012). 

A calibração de sistemas de contadores de corpo inteiro em termos 

experimentais carece de uma abordagem consistente, uma vez que os fantomas 

físicos de corpo inteiro atualmente disponíveis não são padronizados (G. H. Kramer 

& Inn, 1991). Outro problema é que esses simuladores são caros e podem não ser 

facilmente adquiridos por todos os serviços de monitorização in vivo. Sabe-se que 

fantomas de corpo inteiro anatomicamente precisos oferecem uma abordagem mais 

promissora para aprimorar metodologias de calibração, facilitando uma simulação 

precisa levando em consideração a forma humana e reduzindo as incertezas 

associadas à medição. 

O processo de calibração em eficiência de contagem de um CCI pode ser 

também executado computacionalmente, usando fantomas computacionais (Clarke 

et al., 1991). Assim como os fantomas físicos, os computacionais devem replicar as 

características do corpo e tecidos humanos, como a forma, tamanho, densidade e 
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coeficientes de atenuação (ICRU, 1992) para fins de calibração. Existem diversos 

simuladores computacionais utilizados para calcular os coeficientes de calibração 

em eficiência de um CCI (Cristy & Eckerman, 1987; Ferreira et al., 2023; Fonseca et 

al., 2014; Fonseca et al., 2014; ICRP, 2009, 2020; ICRU, 1992; Kim et al., 2008; R. 

Kramer et al., 2003, 2004; Park et al., 2021). Eles são desenvolvidos baseando-se 

nos modelos de homem, mulher e crianças de referência da ICRP.   

Os códigos computacionais que utilizam o método matemático de Monte 

Carlo são ferramentas amplamente validadas e extensivamente aplicadas em 

estudos em diversas áreas de pesquisas e principalmente na etapa de calibração 

em eficiência de contadores de corpo inteiro, conforme demonstrado por Bhati et al. 

(2012), Ferreira et al. (2023), Fonseca et al. (2014a, b), Takahashi et al. (2011) e 

Park et al. (2021). Foi definido pela ICRP um homem de referência como tendo 1,70 

m de altura de 70 kg de massa e uma mulher de referência com 1,60 m de altura de 

60 kg de massa. Na ICRP Publication-110 (ICRP, 2009) foram disponibilizados os 

fantomas computacionais de referência, voxelizados, masculino e feminino e que 

podem ser usados para calcular parâmetros dosimétricos diversos. Mais 

recentemente, os fantomas de referência foram também dispostos em modelo mesh, 

ou malha, na ICRP Publication-145 (ICRP, 2020) e podem ser usados para as 

mesmas aplicações.  

Existem diversas tecnologias de impressão 3D disponíveis que permitem o 

desenvolvimento de fantomas antropomórficos e zoomórficos personalizados para 

diversos fins, como dosimetria em radiodiagnóstico, terapia, proteção radiológica, 

controle de qualidade de equipamentos e ambientes cirúrgicos. Vários estudos já 

foram realizados com o objetivo de produzir fantomas antropomórficos e 

antropométricos para dosimetria em radiodiagnóstico humano (Almeida et al., 2021; 

Badiuk et al., 2022; Cerviño et al., 2017; Halloran et al., 2021; Kiss et al., 2022; T. 

Moratelli et al., 2021; Pereira et al., 2022; Tillery et al., 2022; Tino et al., 2019; 

Winslow et al., 2009). Além disso, há trabalhos publicados acerca do 

desenvolvimento de simuladores zoomórficos para dosimetria e garantia de 

qualidade em radiologia em múltiplas modalidades utilizando a técnica 3D (Andrade, 

Ferreira, et al., 2023; Esplen et al., 2019; Lascaud et al., 2022; Price et al., 2020; 
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Soultanidis et al., 2019; H. Zhang et al., 2018). Resultados satisfatórios foram 

publicados em pesquisas sobre o desenvolvimento de fantomas de calibração de 

tireoide (Manríquez et al., 2016; Moratelli et al., 2021) e rins (Tran-Gia et al., 2016) 

utilizando impressão 3D. 

Os materiais ideais para a construção de tais simuladores físicos devem 

assemelhar-se aos tecidos humanos em suas formas anatômicas, distribuição de 

massa, composição elementar e densidade de massa. Deve também imitar o tecido 

corporal no que diz respeito à sua interação com a radiação ionizante dentro da faixa 

de energia apropriada para a finalidade pretendida para se qualificar como um tecido 

substituto (ICRU, 1989). A representação precisa do tecido é fundamental para 

cálculos e calibrações precisas de doses, que são componentes críticos da proteção 

radiológica e da dosimetria médica. Determinar os coeficientes de atenuação do 

material com precisão é um fator importante na avaliação de materiais tecido 

substitutos. Segundo a ICRU (ICRU, 1989, 1992), um material é considerado tecido 

equivalente se os seus coeficientes de atenuação linear corresponderem aos dos 

tecidos humanos numa faixa de energia específica a sua aplicação. Outros critérios 

listados no Report-44 da ICRU (ICRU, 1989) para interações de radiação em 

materiais tecido-equivalentes incluem o seguinte: seções de choque para partículas 

carregadas e não carregadas; coeficientes de atenuação de mássico e de absorção 

de energia para partículas sem carga; e stopping power mássico total, transferência 

de energia linear e poder de espalhamento mássico para partículas carregadas. 

Várias técnicas experimentais e métodos teóricos são utilizados para calcular 

com precisão os coeficientes de atenuação de um material. As abordagens 

experimentais compreendem a medição da transmissão, dispersão e absorção 

utilizando fontes de radiação que possuem espectros de energia bem definidos 

(Jayachandran, 1971; Jusufbegović et al., 2022; Savi et al., 2021). Abordagens 

teóricas, incluindo simulações de Monte Carlo e modelos analíticos, oferecem 

ferramentas complementares para prever o comportamento de atenuação (Böke, 

2014; Tekin et al., 2017). Estas técnicas fornecem informações sobre as 

características dos materiais em várias energias de radiação e são importantes para 

avaliar a tecido-equivalência dos materiais. 
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No Laboratório de Dosimetria Interna do Centro de Desenvolvimento da 

Tecnologia Nuclear (LDI/CDTN), pesquisadores desenvolveram um fantoma de 

calibração de corpo inteiro masculino de referência utilizando garrafas PET em sua 

produção, nomeado como PET-BOMAB (Paiva et al., 2017). Em sequência, foi 

desenvolvido também um fantoma de cabeça usando diversos materiais tecido-

equivalentes para osso, cérebro e músculo. O objetivo principal foi calibrar o CCI 

para setup de cabeça para monitoração de IOE do serviço de produção de 

radiofármacos para medicina nuclear (Vital et al., 2019). O presente estudo faz parte 

desse mesmo projeto e visa produzir um novo fantoma de corpo inteiro feminino nas 

exatas proporções em tamanho e forma da referência da ICRP-110 (ICRP, 2009), 

com a finalidade de reduzir as incertezas associadas a esses fatores durante a 

calibração de um CCI.  

Fonseca et al. (Fonseca et al., 2014), no SCK-CEN (do holandês, 

Studiecentrum voor de Toepassingen van de Kernenergie) da Bélgica, desenvolveu 

uma biblioteca de fantomas do tipo mesh para estudo do efeito dos tamanhos e 

formas nas medições in vivo. Nela, além de modelos em posição supina, como a 

maioria disponibilizada pelos órgãos oficiais, é possível encontrar variadas posições 

em outros setups, como o de cadeira. Os modelos masculino e feminino adultos 

foram os primeiros a serem criados (Fonseca et al., 2014). Como resultado, 

concluíram que tamanho e forma influenciam significativamente na atenuação da 

radiação nos setups de monitoração com CCI (Fonseca et al., 2014). Dantas (1998) 

também cita que a diferença entre as características do simulador antropomórfico 

usado para calibração e o indivíduo monitorado como um dos fatores de erro 

sistemático em sistemas de monitoração in vivo. Isso demonstra como esses fatores 

influenciam na eficiência de contagem e como fantomas anatomicamente precisos 

permitem uma redução nas incertezas associadas a monitoração in vivo.   

O objetivo desse projeto de pesquisa é utilizar a impressão 3D para construir 

um fantoma físico feminino de tamanho real e utilizando materiais de baixo custo, 

baseado no modelo computacional de referência da ICRP-110 (ICRP, 2009), com o 

propósito de calibrar sistemas CCI. O fantoma físico desenvolvido e apresentado 

nesse trabalho, nomeado como Reference Female Phantom for Internal Dosimetry 
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(RFPID), foi desenvolvido utilizando como referência o fantoma feminino 

computacional da ICRP-110 (ICRP, 2009) e consistiu na impressão 3D do corpo 

inteiro com filamento de ácido polilático (PLA). Devido ao tamanho real do fantoma, 

esse foi dividido em 16 compartimentos com interior oco objetivando o 

preenchimento com um material tecido-equivalente por exemplo, um gel balístico 

que deve ser misturado com uma fonte radioativa, certificada de Eu-152 de atividade 

conhecida.  

O gel balístico é um tecido-equivalente bem estabelecido na área de pesquisa 

balística devido à sua capacidade de emular os atributos mecânicos do tecido 

humano como o impacto ou penetração (Carr et al., 2018; Kerkhoff et al., 2022). 

Com relação a sua aplicação em fantomas, Özdemir et al. (2019) investigaram o uso 

de gel balístico para fantoma de treinamento de estudantes em ultrassonografia e os 

resultados demonstraram-se promissores. Embora extensivamente estudado em 

outras áreas, a caracterização radiológica completa do gel balístico como tecido 

substituto permanece pouco explorada. A pesquisa nesta área é crucial para 

aumentar a precisão e confiabilidade dos materiais para uso em dosimetria e 

calibração. Portanto, neste estudo foi também avaliada a adequação do gel balístico 

como um potencial material tecido-equivalente no desenvolvimento de fantomas 

físicos para calibração de sistema de contador de corpo inteiro, por meio de testes 

experimentais e computacionais. 

 

1.1   ESTRUTURA DA DISSERTAÇÃO  

Este trabalho está estruturado em sete capítulos, o primeiro é a introdução e, 

no capítulo dois, são apresentados o objetivo geral e os objetivos específicos desta 

pesquisa. O capítulo três apresenta a fundamentação teórica com os principais 

conceitos e definições importantes para o entendimento dessa pesquisa. Aqui será 

descrito as unidades e grandezas, conceitos de interação da radiação com a matéria 

e o tecido biológico, dosimetria interna e os sistemas de monitoração in vivo, 

também sobre a calibração desses sistemas e os fantomas utilizados para tal, além 
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de conceitos em impressão 3D. No capítulo quatro, é apresentada a metodologia 

desenvolvida nessa dissertação, ou seja, tudo que tange o desenvolvimento, 

execução, produção e pós processamento do fantoma nomeado como Reference 

Female Phantom for Internal Dosimetry (RFPID) bem como, a produção e os testes 

realizados para estudar a atenuação da radiação no gel balístico. É também 

apresentado diversas modelagens e simulações computacionais do RFPID 

preenchido com o gel balístico para fins de comparação com o modelo heterogêneo 

da ICRP-110.  Os resultados e discussão dos achados estão discorridos no capítulo 

cinco, seguido das conclusões gerais no capítulo seis e, finalmente, algumas 

perspectivas futuras dessa pesquisa são apresentadas no capítulo sete.  
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2   OBJETIVOS 

2.1   Objetivo Geral 

O objetivo desse trabalho é desenvolver um fantoma físico feminino 

antropomórfico e antropométrico de corpo inteiro, em impressão 3D, para calibração 

do sistema contador de corpo inteiro do Laboratório de Dosimetria Interna do Centro 

de Desenvolvimento da Tecnologia Nuclear (LDI/CDTN) usando como base o 

fantoma computacional de voxel feminino de referência da ICRP (ICRP-110). 

2.2   Objetivos Específicos 

Os objetivos específicos alcançados nesse trabalho são: 

 Desenvolver peças imprimíveis de um fantoma a partir da manipulação das 

imagens do fantoma computacional de voxel de referência da ICRP-110 

(ICRP, 2009); 

 Estabelecer os melhores materiais para a impermeabilização e vedação 

completa das peças a fim de evitar riscos de vazamentos de material 

radioativo; 

 Produzir e testar a atenuação do gel balístico como um material tecido-

equivalente; 

 Avaliar o RFPID como um modelo físico potencial para calibração de sistema 

CCI por meio de simulações computacionais utilizando o código MCNP 

(“MCNP® User’s Manual Code Version 6.2”, 2017) e comparações com 

resultados de literatura. 
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3   FUNDAMENTAÇÃO TEÓRICA 

Neste capítulo, serão apresentados os fundamentos teóricos que embasam e 

fundamentam a investigação em foco, fornecendo uma visão abrangente do estado 

atual do conhecimento na área. A estrutura deste capítulo foi elaborada de modo a 

proporcionar uma compreensão abrangente dos fundamentos teóricos que servirão 

de base para a análise e interpretação dos resultados obtidos ao longo deste 

trabalho. A organização das informações visa fornecer uma base sólida para a 

construção do argumento que sustenta a pesquisa e suas conclusões, identificar 

lacunas e justificar a relevância e originalidade desta investigação em relação ao 

contexto acadêmico e científico. 

3.1   GRANDEZAS E UNIDADES DE MEDIDA 

Quando se trata de radiação, a definição de suas unidades e grandezas é 

feita a partir da correlação entre grandezas radiológicas associadas ao campo de 

radiação com outra grandeza do sistema tradicional de medidas, como tempo e 

área. Assim é possível inferir grandezas como Atividade e Fluência. Ao relacionar a 

interação da radiação com um meio material e a quantidade de energia ali 

depositada é possível obter as chamadas grandezas dosimétricas, como a dose 

absorvida. De outro modo, quando são levadas em consideração as consequências 

deletérias da radiação no organismo humano, são introduzidos fatores de 

ponderação para associar as grandezas dosimétricas limitantes como, a dose 

equivalente, dose equivalente no órgão, dose efetiva, dose efetiva comprometida. 

Existem também as chamadas grandezas operacionais, aplicadas em proteção 

radiológica na monitoração ambiental e de monitoração pessoal, como é o caso do 

equivalente de dose ambiente e equivalente de dose pessoal.  

As instituições internacionais que definem as grandezas, suas relações e 

unidades são a Comissão Internacional de Proteção Radiológica (ICRP, do inglês 

International Comission on Radiation Protection) e a Comissão Internacional de 

Unidades e Medidas de Radiação (ICRU, do inglês International Comission on 

Radiation Units and Measurements). A primeira faz recomendações sobre 
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grandezas limitantes e, a segunda, sobre as grandezas básicas e operacionais. No 

Brasil, a principal norma de aplicação das grandezas radiológicas é da Comissão 

Nacional de Energia Nuclear (CNEN), órgão de regulamentação na área nuclear do 

Brasil. As suas principais prerrogativas acerca do assunto se encontram na norma 

CNEN NN 3.01 de 2014 “Diretrizes Básicas de Proteção Radiológica” e suas 

Posições Regulatórias complementares (CNEN, 2014). Abaixo são descritas as 

grandezas e suas definições no campo da dosimetria das radiações de acordo com 

as normas ICRP-103 (ICRP, 2007a) e CNEN NN 3.01. 

Atividade (A) – número de decaimentos, ou transformações nucleares, de uma 

fonte radioativa por unidade de tempo. No Sistema Internacional de medidas, é dado 

por becquerel (Bq = s-1).  

Atividade Incorporada (I) – aplicada em dosimetria interna, a atividade incorporada 

refere-se à atividade de um radionuclídeo incorporado internamente por um 

indivíduo por meio trato respiratório, gastrointestinal ou pela pele. Pode ser aguda ou 

crônica, no primeiro caso trata-se de uma ingestão ou inalação única e, a segunda, 

de uma incorporação durante um período específico (ICRP, 2007a).  

Dose Absorvida (D) – relação entre a média de energia de radiação depositada em 

um material por unidade de massa, em um ponto de interesse. É dada em joule por 

quilograma (J.kg-1), conhecida como gray (Gy).  

Dose Equivalente (H) – é o produto de D por Q em um ponto, sendo D a dose 

absorvida no tecido e Q o fator de qualidade da radiação específica do estudo. A 

Tabela 1 fornece os fatores de peso de acordo com a radiação. Essa grandeza é 

dada em Joule por quilograma (J.kg-1), em sievert (Sv).  
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Tabela 1. Fator de qualidade da radiação 

Tipo de Radiação Fator de qualidade Q 

Raios X, Radiação γ e elétrons 1 

Prótons e partículas com uma (1) unidade de carga e com massa de 

repouso maior que uma unidade de massa atômica e de energia 

desconhecida 

10 

Nêutrons com energia desconhecida 20 

Radiação α e demais partículas com carga superior a uma (1) unidade de 

carga 
20 

Fonte: Adaptado ICRP, 1991 

 

Dose Efetiva (E) – soma das doses equivalentes no tecido ponderada pelo fator de 

peso do tecido ou órgão, wT.  É dada em Joule por quilograma (J.kg-1), em sievert 

(Sv). Os fatores de ponderação dos órgãos são encontrados na ICRP-27 e ICRP-60.  

Dose Efetiva Comprometida E(τ) – usado em dosimetria interna em casos de 

contaminação, é dada como a soma dos produtos das doses equivalentes em 

órgãos ou tecidos comprometidas e os fatores de ponderação tecidual (wT) 

apropriados, onde τ é o tempo de integração em anos após a ingestão. O período de 

compromisso é de 50 anos para adultos e de 70 anos para crianças.  

Cada uma dessas grandezas desempenha um papel importante em diferentes 

áreas da física das radiações, radiobiologia e dosimetria, fornecendo uma base 

sólida para a avaliação e quantificação dos efeitos da radiação em materiais 

biológicos. Elas não apenas auxiliam na compreensão das interações radiação com 

a matéria, mas também são essenciais na determinação da dose absorvida em 

diferentes contextos de aplicação. 

3.2   INTERAÇÃO DA RADIAÇÃO COM A MATÉRIA 

As radiações podem ser classificadas em duas categorias: não ionizante e 

ionizante. As radiações ionizantes são capazes de causar ionização em um átomo 

ou molécula, arrancando elétrons de suas camadas, caso contrário, é considerada 
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não ionizante. Podem ser subdivididas em radiações eletromagnéticas ou 

corpusculares, carregadas ou não carregadas. As radiações eletromagnéticas são 

constituídas de campos elétricos e campos magnéticos oscilantes perpendiculares 

entre si, não possuem carga ou massa, consistindo em ondas com amplitudes, 

frequências (ν), velocidades e comprimentos de onda (λ) específicos. Exemplo 

dessas radiações são os raios X e gama. Por outro lado, a radiação corpuscular é 

composta por partículas ou núcleos atômicos, incluindo elétrons, pósitrons, prótons e 

nêutrons. Dentre esses, apenas o nêutron é uma partícula não carregada. As 

radiações ionizantes são tipicamente classificadas em três grupos: radiação 

eletromagnética, partículas carregadas e nêutrons livres (Okuno & Yoshimura, 2010) 

 

3.2.1 Interação de partículas carregadas  

Partículas carregadas têm uma probabilidade de interação de 100% com o 

meio material devido à presença de cargas distribuídas e à ação da força 

coulombiana de longo alcance. Seguindo o conceito da aproximação de 

desaceleração contínua (CSDA do inglês, continuous slowing-down approximation), 

a trajetória de uma partícula carregada através da matéria envolve uma sequência 

contínua de interações, resultando na perda progressiva de sua energia até não ser 

mais considerada uma radiação ionizante (Yoshimura, 2009).  

As interações das partículas carregadas ocorrem frequentemente com a 

nuvem eletrônica e, em menor escala, com o núcleo atômico ou com o átomo como 

um todo. Segundo Okuno e Yoshimura (2010), essas interações ocorrem de seis 

formas e sua ocorrência dependerá da velocidade, massa, carga da partícula e do 

parâmetro de impacto da colisão, ou seja, a distância entre a trajetória da partícula e 

o centro de forças. Essas interações estão abaixo exemplificadas e, ao fim, a Tabela 

2 apresenta um resumo dos tipos de partículas carregadas e as interações com 

maiores probabilidades de ocorrência.  

1. Colisão inelástica com o átomo (colisão suave): raramente essa interação 

resulta em ionização, mas majoritariamente em excitação. Trata-se da 
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interação da partícula com todo o átomo ou camadas eletrônicas externas, 

em que a partícula tem uma pequena perda de energia e de momento. É mais 

frequente em partículas pesadas.   

2. Colisão inelástica com um elétron fortemente ligado (colisão dura): 

refere-se à colisão frontal entre partícula e elétron em que pode ocorrer 

ionização do átomo e grande perda de energia pela partícula. Existe a 

possibilidade de o elétron ejetado receber energia cinética suficiente para 

desviar da trajetória da partícula inicial com um longo alcance e produzir 

novas ionizações, conhecido como raio delta. 

3. Colisão elástica com o núcleo: a partícula primária sofre uma mudança 

considerável em sua trajetória ao se aproximar do núcleo, o núcleo então 

recua compensando o momento.  

4. Colisão inelástica com o núcleo: no processo conhecido como 

bremsstrahlung, a partícula perde grande parte de sua energia, ou toda ela, 

ao desviar sua trajetória devido a sua aproximação com o núcleo atômico. A 

essa energia é liberado como um fóton de raios X, conhecido como raio X de 

bremsstrahlung ou de frenamento.  Quanto mais próxima estiver a partícula 

do núcleo, no momento do desvio, maior será a energia do fóton.  

5. Aniquilação de pósitron: usualmente ocorre entre um pósitron com 

baixíssima velocidade com um elétron em repouso no meio, resultando na 

produção de dois fótons diametralmente opostos com energias de 511 keV. 

Quando essa interação ocorre com o pósitron ainda em grande velocidade, é 

dado o nome de aniquilação em voo. À medida que o pósitron se aproxima do 

elétron, ele desacelera e esse processo resulta na liberação de fótons gama 

de energias mais altas. 

6. Reações nucleares: ocorre apenas em energias muito elevadas (ordem de 

GeV) e não há aplicações médicas de partículas nessa faixa de energia. Para 

essas energias, ocorrem interações diretas com o núcleo ou com nucleons 

individualmente.  
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Tabela 2. Interações de partículas carregadas com a matéria 

Partícula 

carregada 

Interações 

possíveis 

O que muda no meio 

de interação 
Radiação ionizante produzida 

Elétrons, 

pósitrons e íons 

pesados 

Colisão inelástica 

com o átomo 

(colisão suave) 

Excitação e eventual 

ionização de átomos em 

camada e valência 

Partícula primária com pequena 

mudança de direção, 

eventualmente um elétron rápido 

(secundário) 

Colisão com elétron 

fortemente ligado 

(colisão dura) 

Ionização (camada 

interna) e excitação do 

átomo 

Partícula primária, elétron rápido 

(secundário), raios X 

característicos, elétrons Auger 

Choque elástico 

com o núcleo 
Recuo do núcleo 

Partícula primária com mesma 

energia e outra trajetória 

Elétrons e 

pósitrons 

Choque inelástico 

com o núcleo 
Recuo do núcleo 

Partícula primária e radiação de 

fretamento (bremsstrahlung) 

Pósitrons 
Aniquilação com 

um elétron do meio 

Ionização e excitação 

do átomo 

Dois fótons de aniquilação, cada 

um com energia maior ou igual a 

511 keV 

Todos  Reação nuclear 
Núcleo modificado (Z ou 

A) e excitado 

Partículas subnucleares, raios 

gama de desexcitação nuclear 

Fonte: Yoshimura, 2009 

 

3.2.2 Interação de fótons 

De acordo com Yoshimura (2009), na grande maioria dos casos, a radiação 

eletromagnética é tratada como um conjunto de partículas chamadas fótons. Elas 

podem ou não interagir com o meio, ou seja, ela pode percorrer uma trajetória 

extensa sem modificá-lo ou se modificar. A probabilidade de interação varia 

conforme as características do meio e da radiação. Neste contexto, a energia dos 

fótons (Eν) geralmente é expressa em unidades de elétron-volts (eV) e pode ser 

calculada pela seguinte equação: 

𝐸𝛾 = ℎ ∙  𝜈       (Equação 1) 
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na qual ℎ é a constante de Planck e ν a frequência. 

 

  Segundo Yoshimura (2009), as interações das radiações eletromagnéticas 

(energias de keV a MeV) com o meio podem ocorrer de cinco formas abaixo citadas, 

sendo as três primeiras as principais.  

1. Efeito fotoelétrico: um fóton interage com um elétron depositando toda sua 

energia e esse elétron é ejetado com uma energia igual a diferença da enrgia 

do fóton pela energia de ligação do elétron na camada. É predominante em 

baixas energias. 

2. Efeito Compton (ou espalhamento inelástico): um fóton transfere parte de 

sua energia e momento para um elétron do meio e sofre mudança na sua 

trajetória com a energia igual à diferença entre a energia inicial do fóton e a 

energia transferida para o elétron.  

3. Produção de pares elétron-pósitron: um fóton é absorvido e sua energia é 

convertida em massa de repouso e energia cinética de um par 

elétron/pósitron. Predominante em altas energias e necessita de uma energia 

mínima de 1,022 MeV para sua ocorrência. 

4. Espalhamento coerente (ou efeito Rayleight):  um fóton é absorvido e 

reemitido em uma direção diferente da inicial. 

5. Reações fotonucleares: um fóton com energia maior que a energia de 

ligação de nucleons libera um nêutron e um próton com energia cinética 

suficiente para escapar do núcleo atômico, gerando outro elemento. Esse 

efeito é conhecido como fotodesintegração ou efeito fotonuclear. 

Todo processo que transfere energia suficiente para ejetar um elétron das 

camadas eletrônicas mais internas (K e L), abre uma vacância que é preenchida por 

outro elétron de camadas mais externas. A diferença de energia, liberada nesse 

processo, resulta na emissão de um raio X característico. Esse raio X pode, ainda, 

transferir energia suficiente para arrancar um elétron de uma camada mais externa, 

sendo este chamado de elétron Auger.  
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Os três principais tipos de interação desses fótons com a matéria estão 

ilustrados na Figura 1. Nestas energias, para o número atômico efetivo do tecido 

mole (≈ 7), o efeito Compton é o mais predominante. A Tabela 3 mostra um resumo 

das interações das radiações eletromagnéticas com a matéria.  

 

Figura 1. Os três principais processos de interação dos fótons com a matéria em função da energia 

do fóton e do número atômico do meio material 

 

Fonte: Adaptado de Knoll (2010). 

 

Tabela 3. Resumo das interações das radiações eletromagnéticas com a matéria 

Interação O que muda no meio 
O que muda na radiação 

incidente 

Radiação ionizante 

produzida 

Efeito 

Fotoelétrico 

Ionização e excitação 

do átomo, recuo do 

núcleo 

Fóton é absorvido 

Elétron rápido, raios X 

característicos, elétron 

Auger. 

Efeito 

Compton 
Ionização do átomo 

Fóton perde energia e 

muda de direção 

Elétron rápido, fóton com 

menor energia é 

espalhado 

Produção de 

Pares 

Recuo do núcleo; 

aniquilação do pósitron 
Fóton é absorvido 

Elétron e pósitron rápidos, 

raios X de aniquilação 

Espalhamento 

Coerente 
- 

Direção de propagação, 

(mantém energia) 

Radiação eletromagnética 

espalhada de mesma 

energia 

Reação 

Fotonuclear 

Núcleo modificado (Z ou 

A) e excitado 
Fóton é absorvido 

Partículas subnucleares, 

em geral nêutrons 

Fonte: Adaptado de Yoshimura, 2009 
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A Lei da Atenuação é um princípio fundamental da física das radiações que 

descreve como a intensidade de uma radiação ionizante diminui à medida que 

atravessa um material absorvente. Essa lei é especialmente aplicável a radiações 

eletromagnéticas. Essa lei permite determinar a eficiência do material com a qual ele 

atenua a radiação. Quanto maior for a densidade desse material, maior será a 

absorção e, consequentemente, maior a eficiência desse material em atenuar o feixe 

de radiação.  A Equação 2 descreve matematicamente essa lei (Okuno & 

Yoshimura, 2010). 

𝐼 = 𝐼𝑜 ∙ 𝑒−𝜇𝑥      (Equação 2)  

onde, 𝐼 representa a intensidade final do feixe de fótons após passar pelo 

material, 𝐼𝑜 é a intensidade inicial do feixe, μ é o coeficiente de atenuação linear e 𝑥 

é a espessura do material. 

O coeficiente de atenuação linear (µ) está diretamente relacionado à 

densidade do material e à energia da radiação incidente e é dado por cm-1 (ICRU, 

1989; Yoshimura, 2009). Quando o coeficiente de atenuação linear é normalizado 

pela densidade do material, é nomeado como coeficiente de atenuação mássico 

(µ/ρ). Ele é particularmente útil na comparação de materiais com densidades 

diferentes, pois considera a atenuação em relação à massa presente do material. 

Sua unidade é dada em cm2.g-1 (ICRU, 1989). 

 

3.3   DOSIMETRIA INTERNA DE RADIONUCLÍDEOS 

Diferentemente da dosimetria externa, na qual é feita o cálculo de dose de 

uma fonte de radiação externa, o termo dosimetria interna refere-se a medição, 

cálculo, estimativa, previsão e quantificação da dose absorvida por um indivíduo que 

tenha incorporado um radioisótopo, seja por meio de ingestão oral, inalação, injeção 

ou absorção pela pele. Isso pode ocorrer de forma intencional, como em técnicas de 

diagnósticos de medicina nuclear, ou acidental, em indivíduos ocupacionalmente 

expostos (IOE) ou do público em geral.   
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Documentadamente, a dosimetria interna ocupacional surgiu entre 1953 e 

1955, a partir da necessidade de calcular e limitar as doses recebidas pelos 

trabalhadores após exposições ocupacionais (ICRP, 1995; National Committee on 

Radiation Protection, 1953). Em 1959, a ICRP publicou a agora conhecida como 

ICRP Publication 1 (ICRP, 1959), na qual foi estendido a necessidade de 

monitoração a toda população e, mais recentemente na ICRP Publication 108 de 

2008 (ICRP, 2008), a organismos não humanos que vivem em um ambiente 

contaminado.  

Segundo Potter (2005), a dosimetria interna ocupacional pode ser classificada 

com três finalidades, sendo elas, o controle do local de trabalho, intervenção médica 

e cumprimento de normas e regulamentos. A depender do tipo de exposição e seu 

cenário de ocorrência, ela é classificada em três áreas principais: exposição 

ocupacional, exposição médica e exposição pública. O Commitee on Medical 

Internal Radiation Dose (MIRD) desenvolve modelos matemáticos para cálculos em 

dosimetria interna aplicados à medicina nuclear, com incorporação de radiofármacos 

(Howell et al., 1999) e segue em constante evolução de seus modelos até os dias de 

hoje. 

A contaminação por exposição ocupacional ocorre principalmente por 

inalação ou absorção pela pele ou por meio de feridas. Na exposição médica, por 

meio de injeção ou ingestão oral. A exposição do público é ocasionada 

principalmente de forma oral com alimentos e água contaminada e, em menor 

escala por inalação. Essa realidade é invertida em casos de acidentes nucleares, 

onde a inalação se torna a principal fonte de exposição (Li, 2018).  

Quando se trata de incorporação de radioisótopo, as doses equivalentes e 

efetivas são acumuladas no decorrer do tempo, uma vez que as doses nos órgãos e 

tecidos são prolongadas devido a emissão contínua do radioisótopo até que ele seja 

completamente eliminado do corpo. Deste modo, a soma das quantidades 

resultantes dessas doses é definida como dose efetiva comprometida (DEC), dada 

em Sievert. A ICRP-103 estabelece a dose efetiva comprometida como: 
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A soma dos produtos do órgão comprometido ou doses equivalentes de 
tecido e os fatores de ponderação de tecidos apropriados (wT), onde t é o 
tempo de integração nos anos após a ingestão. O período de compromisso 
é de 50 anos para adultos e 70 anos para crianças (ICRP, 2007a). 

 

O cálculo da DEC pode ser feito por meio de dois métodos. No primeiro, o 

cálculo inicia a partir do conhecimento da ingestão do radionuclídeo e sua via de 

entrada (se oral, inalada ou absorvida) e então define-se a deposição e retenção dos 

radioisótopos nos órgãos e tecidos de acordo com suas características químicas. A 

dinâmica de comportamento dos radioisótopos no corpo humano é descrita por meio 

de modelos biocinéticos, uma vez que, quando incorporados, os radioisótopos 

podem se alocar no trato respiratório ou gastrointestinal e transferir-se para outros 

órgãos e tecidos por meio do fluxo sanguíneo, com excreção pelos rins ou intestino 

(Paquet, 2022). Existem diversos modelos biocinéticos disponibilizados pela ICRP 

de acordo com a via de ingestão (ICRP, 1989, 1994a, 1994b, 1995, 2006). O 

segundo passo do método consiste na determinação do número de decaimentos 

nucleares em cada órgão, ou grupo de órgãos que compartilham as mesmas 

características, durante o tempo de retenção do radionuclídeo e, em seguida, a 

energia emitida ao longo desses decaimentos. Essas informações estão disponíveis 

em literatura de acordo com os radionuclídeos e seus tipos de desintegrações 

(ICRP, 2007b). Por fim, modelos dosimétricos e códigos computacionais de 

transporte de partículas de radiação são utilizados para calcular a dose absorvida 

nos tecidos e, finalmente, são utilizados os fatores de ponderação da radiação para 

calcular a dose equivalente comprometida aos órgãos e então os fatores de 

ponderação dos tecidos para calcular a dose efetiva comprometida.  

O segundo método de cálculo da DEC são os bioensaios in vitro e in vivo. O 

in vitro consiste em um método indireto de avaliação da incorporação principalmente 

por meio de urina, fezes, sangue e ar exalado. Em casos especiais, cabelo, dentes e 

esfregaços de nariz também podem ser utilizados (IAEA, 1999). Os bioensaios in 

vivo consistem na avaliação qualitativa e quantitativa por meio de monitoração direta 

do indivíduo com uso de detectores de radiação e a aquisição do espectro durante 

um tempo padrão. A análise desse espectro permitirá a qualificação e quantificação 

dos radionuclídeos incorporados. Genericamente, os laboratórios em que esse 
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procedimento é executado é chamado de Contador de Corpo Inteiro e é de grande 

importância na área de radioproteção e dosimetria (IAEA, 1996b, 1996a; ICRP, 

1997; NCRP, 1980, 1987). 

O estudo desenvolvido e apresentado nesse trabalho é focado em bioensaios 

in vivo, mais especificamente Contadores de Corpo Inteiro e sua calibração com 

fantomas físicos antropomórficos. A seguir serão tratados em mais detalhes o 

funcionamento desses sistemas e dos laboratórios de dosimetria interna nos quais 

eles são aplicados.  

 No Brasil existem sistemas CCI em apenas cinco instituições, sendo elas o 

Centro de Desenvolvimento da Tecnologia Nuclear (CDTN), Instituto de Pesquisas 

Energéticas e Nucleares (IPEN), Instituto de Radioproteção e Dosimetria (IRD), 

Centro Regional de Ciências Nucleares do Nordeste (CRCN) e Central Nuclear 

Almirante Álvaro Alberto (CNAAA). Em respostas a emergências radiológicas e 

nucleares que necessitem bioanálises in vivo, essas são as instituições a responder 

por todos os 26 estados e ao Distrito Federal do Brasil. A Figura 2 apresenta um 

exemplo dos sistemas CCI do CDTN, IRD e IPEN. 

  

Figura 2. Sistemas CCI em instituições brasileiras. 

   

Em A) CCI do CDTN, geometria tipo maca; em B) CCI do IRD, geometria tipo cadeira e; C) CCI do 

IPEN, geometria do tipo cadeira. 

Fonte: Acervo pessoal do autor (CDTN); Reprodução da internet sites oficiais (IRD e IPEN) 

 

A) B) C) 
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No mundo, o número de sistemas CCI varia em cada país de acordo com 

seus investimentos e necessidades, no Japão, por exemplo, existem mais de 60 

(Hayano et al., 2014). A Europa também tem diversas instituições com CCI, pelo 

menos 37 participaram ativamente do exercício de intercomparação da EURADOS 

(do inglês, European Radiation Dosimetry Group) publicado em outubro de 2023 sob 

o título “EIVIC-2020: European In-Vivo Intercomparison Exercise 2020 - Organisation 

of a European Interlaboratory Comparison on Whole-Body Counting” (Franck et al., 

2023). No ARADOS (do inglês, Asian Radiation Dosimetry Group), pelo menos 18 

instituições do Japão, China, República da Coréia, Malásia e Vietnã compõe o grupo 

com os mesmos objetivos do EURADOS. Na América Latina, o REPROLAM (do 

espanhol, Red de Optimización de Protección Radiológica Ocupacional em 

Latinoamérica y el Caribe), conta com diversas instituições do bioensaios in vivo, 

porém não disponibilizou ainda a lista de instituições participantes. A Figura 3 

apresenta alguns exemplos de laboratórios internacionais como o SCK-CEN da 

Bélgica, o da Agência Internacional de Energia Atômica na Áustria e o CIEMAT da 

Espanha.  

Figura 3. Sistemas CCI em instituições internacionais 

  

A) 

B) C) 
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Em A) CCI do CIEMAT da Espanha, geometria tipo cadeira; em B) CCI do SCK-CEN da Bélgica, 

geometria do tipo cadeira e; em C) CCI da AIEA, geometria tipo maca. 

Fonte: (B. P. López et al., 2020); Reprodução internet sites oficiais (SCK-CEN e AIEA) 

   

 3.3.1 Laboratórios de Dosimetria Interna 

Os Laboratórios de Dosimetria Interna (LDI) são normalmente equipados com 

vários sistemas de monitoração de corpo inteiro ou partes do corpo de um indivíduo 

do público. O sistema de contador de corpo inteiro consiste em uma sala blindada 

com o objetivo de reduzir ao máximo a radiação de fundo para que no momento da 

monitoração do IOE e aquisição do espectro não haja interferência de outras fontes 

além do que a emitida pelo indivíduo contaminado. Essa blindagem pode ser 

realizada de várias formas, como por exemplo, de revestimento da sala inteira ou 

apenas em torno do detector. De acordo com Dantas (1998), deve-se considerar 

diversos fatores na escolha da blindagem como custos envolvidos, tipo de radiação 

e energia mínima detectável no serviço, sensibilidade do detector utilizado e, em 

radiometria, essa escolha é feita de forma semiempírica e baseada nas experiências 

do setor. Diversos materiais podem ser utilizados como materiais de blindagem em 

análises radiométricas, como chumbo, ferro, aço, concreto, mercúrio, água, dolomita 

e sacarose (IAEA, 1996b; Knoll, 2010; Paschoa et al., 1993). 

Os sistemas de monitoração individual são desenhados de forma que haja 

uma geometria de contagem ou um setup onde o indivíduo e o detector estão 

posicionados promovendo a máxima eficiência do sistema. Desta forma, um sistema 

computacional de aquisição do espectro de energia, emitido por uma fonte 

radioativa, que pode estar internamente no individuo contaminado, é obtido e uma 

análise de espectrometria gama (fótons) é possível de ser realizada. Os 

radionuclídeos suscetíveis a detecção são os com emissão de fótons com energia 

suficientemente alta e com alta probabilidade de ocorrência de decaimento (Dantas, 

1998). Os radionuclídeos que não têm essa característica e são importantes para a 

dosimetria interna como, o Th-232, U-238 e Ra-226, são detectados por meio da 

energia dos seus radionuclídeos filhos. Além disso, o tempo de monitoração, a 
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geometria fonte-detector e a atenuação da radiação pelos tecidos são fatores 

limitantes nesse tipo de medição (IAEA, 1996b).  

As incertezas associadas às análises in vivo, de acordo com Dantas (1998), 

podem ser categorizadas em aleatórias ou sistemáticas. A primeira está associada a 

cada parâmetro utilizado no cálculo de atividade, estimada por meio de métodos 

matemáticos de propagação de erros estatísticos. A segunda, refere-se a uma série 

de erros relacionados a fatores que vão desde os sistemas eletrônicos até 

diferenças entre simuladores utilizados e o corpo humano do indivíduo de interesse. 

  Para erros aleatórios, é importante que se tente reduzir ao máximo as 

incertezas geradas pelo fator de calibração1, que é diretamente relacionado ao 

método utilizado para produzir o simulador antropomórfico e ao procedimento 

adotado na calibração dos sistemas de detecção (Dantas, 1998).  

Para erros sistemáticos, sua quantificação pode ser difícil a depender do fator 

causador. Dentre esses fatores, podem ser citados: instabilidade de sistemas 

eletrônicos, geometria fonte-detector, movimentação do indivíduo durante 

monitoração, diferença da distribuição do radionuclídeo, densidade e coeficiente de 

atenuação linear da radiação, além das diferenças entre as características do 

simulador antropomórfico utilizado na calibração e o corpo do indivíduo monitorado 

(Dantas, 1998).  

 

3.3.1.1   Geometria de contagem 

Um fator importante que impacta nas medições é a geometria fonte-detector, 

no qual a fonte é o próprio indivíduo monitorado. Para corpo inteiro, existem quatro 

geometrias aplicáveis, sendo elas arco, cadeira, maca e varredura com vários 

detectores (Figura 4). Estas configurações de corpo inteiro são utilizadas na 

medição de radionuclídeos que emitem energia acima de 100 keV. As atividades 

                                            
1 Valor utilizado para ajustar ou corrigir uma medição experimental para que ela 

corresponda a valores de referência conhecidos ou padrão, a fim de corrigir possíveis desvios ou 
variações nas respostas do sistema de detecção. 
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obtidas por meio dessas medições, utilizadas como base para o cálculo da dose, 

considera que os radionuclídeos apresentam distribuição uniforme pelo corpo. Isso 

se deve ao fato de que a calibração dos detectores é realizada considerando esse 

padrão de distribuição como pressuposto (Dantas, 1998).  

 

Figura 4. Tipos de geometria de contagem em sistemas CCI 

 

Em A) geometria tipo arco; B) geometria tipo cadeira; C) geometria tipo maca; e D) geometria tipo 

varredura com vários detectores 

Fonte: Adaptado de Dantas, 1998 

 

Na geometria tipo arco, o indivíduo deita-se em uma base tipo arco de forma 

que todas as partes do corpo fiquem equidistantes em relação ao detector, que está 

a aproximadamente 1,5 a 2 m de distância do indivíduo. Essa distância diminui 

consideravelmente a sensibilidade de detecção (Hess & McNeff, 1947). Dessa 

forma, essa geometria é indicada apenas em casos em que a contaminação já é 

previamente conhecida e não no controle ocupacional de rotina, onde a eficiência de 

detecção deve ser a maior possível. 

A) B) 

C) D) 

detector 

detector 

detector 

detector 

detectores 

detectores 
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Na configuração conhecida como "cadeira", o indivíduo é posicionado com um 

ângulo de 90º entre o tórax e as coxas, enquanto o detector é colocado a uma 

distância aproximada de 50 cm da cadeira. A resposta do detector será influenciada 

pela distribuição da contaminação, o que pode resultar em variações na eficiência 

em até um fator de 2 ou mais, em comparação com contaminações uniformemente 

distribuídas ou localizadas nos pulmões ou no fígado (Dantas, 1998). Nestes 

cenários, a IAEA (1996a) classifica esse tipo de erro sistemático como sendo muito 

mais significativo em geometrias do tipo cadeira do que naquelas do tipo arco. 

 Na configuração conhecida como geometria tipo maca, vários detectores são 

posicionados em diferentes pontos direcionados ao indivíduo que se encontra 

deitado em posição supina. Essa abordagem mantém uma alta eficiência de 

detecção e proporciona uma resposta combinada consistente, independentemente 

da distribuição do radionuclídeo, embora tenha um custo elevado. Uma grande 

vantagem desse método é que o processamento dos espectros individuais viabiliza 

inferências sobre o real padrão de distribuição do radionuclídeo ao longo do corpo 

do indivíduo sob monitoramento (Dantas, 1998).  

 Por fim, na geometria conhecida como varredura, um ou dois detectores são 

instalados em suportes que se deslocam ao longo de eixos horizontais estáticos ou 

em movimentos de rotação elíptica sobre o indivíduo deitado em posição supina 

(Anderson et al., 1969). Essa configuração proporciona informações precisas sobre 

a distribuição do radionuclídeo, além de uma geometria de detecção mais uniforme. 

Contudo, os componentes mecânicos dos suportes implicam em custos e 

necessidade de manutenção mais elevados (Dantas, 1998). 

 

3.3.1.2   Sistema de detecção 

Para a escolha de um detector para aplicação nesses sistemas, deve-se levar 

em conta diversos fatores como a eficiência de detecção intrínseca, resolução em 

energia, disponibilidade de tamanho, o efeito da radiação de fundo no espectro em 

regiões de interesse (ROI), possibilidade de aplicação de métodos anti-coincidência, 
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estabilidade de operação no decorrer do tempo e o custo (Dantas, 1998). Para 

detecção de radionuclídeos emissores de fótons com energia acima de 100 keV, os 

detectores cintiladores inorgânicos com cristais de NaI(Tl) têm sido os mais 

utilizados. As maiores vantagens de seu uso estão na alta eficiência, facilidade de 

operação e disponibilidade em vários tamanhos (Dantas, 1998). No entanto, ele tem 

baixa resolução em energia, o que dificulta análises de contaminação com vários 

radionuclídeos com energias próximas (IAEA, 1996a). Além disso, nos detectores 

NaI(Tl) de grande volume, a radiação de fundo é alta para energias abaixo de 100 

keV, o que o faz inviável para detecção de radionuclídeos importantes em dosimetria 

interna como o Am-241, U-238 e isótopos de plutônio.  

Para contornar esse problema, cristais de CsI(Tl) acoplados a um cristal de 

NaI(Tl) e a uma célula fotomultiplicadora, conhecidos como detectores phoswich, 

foram desenvolvidos. Isso melhorou a resolução em energia devido a anti-

coincidência obtida com essa combinação, uma vez que o tempo de decaimento dos 

dois cintiladores são diferentes e a chegada de um mesmo fóton nos dois cristais 

geravam dois pulsos de diferentes formatos, que eram eliminados por meio de um 

analisador de pulso. Isso reduziu significativamente a radiação de fundo em baixas 

energias (Laurer, 1968) e tiveram larga aplicação principalmente na década de 70 

até o surgimento dos detectores semicondutores de germânio, que os substituíram.  

A alta resolução em energia dos detectores semicondutores é sua principal 

vantagem. Essa característica advém da baixa energia necessária para formar um 

par elétron-buraco (≈3 eV) e consequente baixa flutuação estatística no número de 

pares formados na interação do fóton com o cristal (Knoll, 2010). Deste modo, 

detectores semicondutores conseguem identificar vários radionuclídeos com 

precisão, uma vez que sua resolução em energia se situa na faixa de 1 keV, 

ademais, há uma melhor relação sinal/ruído que decorre na redução de incertezas 

na estimativa da radiação de fundo abaixo dos picos de interesse (Dantas, 1998). 

A principal desvantagem dos detectores semicondutores de germânio é a 

necessidade de resfriamento com nitrogênio líquido, o que o torna altamente 

oneroso, mas essa desvantagem é superada por suas várias vantagens de detecção 
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(IAEA, 1996a). Os detectores de germânio hiperpuro (HPGe) são os mais utilizados 

em monitoração in vivo atualmente. A depender dos recursos disponíveis, os 

serviços optam pelo uso de dois ou mais detectores objetivando aumentar a 

sensibilidade de detecção para monitoração individual de radionuclídeos de baixa 

energia (Toohey et al., 1991). Em aspectos gerais, os detectores mais utilizados no 

Brasil em monitoração in vivo são os cintiladores inorgânicos NaI(Tl) e os 

semicondutores HPGe (Dantas, 1998) a Figura 5 mostra a diferença entre os 

espectros desses dois detectores. 

 

Figura 5. Diferença espectros dos detectores iodeto de sódio e germânio 

 

Fonte: Knoll, 2010 
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3.3.1.3   Detector NaI(Tl) e calibração 

Para este trabalho foi utilizado um detector cintilador inorgânico de iodeto de 

sódio (NaI(Tl)) e, antes de explicar os meios de sua calibração, esse subtópico 

abordará brevemente o funcionamento desse tipo de detector.  

Os materiais inorgânicos apresentam cintilação devido aos estados 

energéticos resultantes de suas estruturas cristalinas. Nos semicondutores, elétrons 

ocupam bandas de energia específicas: a banda de valência de menor energia, com 

elétrons fortemente ligados à rede, e a banda de condução de energia mais elevada, 

que abriga elétrons com capacidade de se deslocar através do cristal. Entre essas 

bandas está a banda proibida, onde elétrons raramente são encontrados em cristais 

puros. A largura dessa banda define os materiais como isolantes (banda larga, 

> 5 eV, semicondutores (aproximadamente 1 eV) e condutores (bandas estreitas) 

(Knoll, 2010). 

Quando absorvem energia de um fóton ou de uma partícula carregada, os 

elétrons podem ser impulsionados de sua posição na banda de valência para a 

banda de condução, criando um "buraco" onde antes havia um elétron na banda de 

valência. Contudo, em cristais puros, o retorno desse elétron à banda de valência, 

acompanhado pela emissão de um fóton, é um processo pouco eficiente, e os fótons 

emitidos possuem energia muito alta para estar na faixa do espectro visível. Para 

aumentar a probabilidade de emissão de fótons visíveis durante o processo de 

desexcitação, impurezas ativadoras são adicionadas, criando sítios especiais na 

estrutura do material, diminuindo a largura da banda proibida. Isso gera níveis 

energéticos intermediários na banda proibida, permitindo a emissão de fótons na 

faixa visível e, consequentemente, a cintilação (Knoll, 2010). A Figura 6 mostra um 

desenho esquemático da estrutura de bandas de um detector cintilador. 
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Figura 6. Estrutura de banda de um cristal cintilador ativado 

 

Fonte: Adaptado de Knoll, 2010 

  

Em detectores cintiladores são utilizadas as chamadas fotomultiplicadoras, 

dispositivos que transformam os sinais luminosos produzidos pela radiação em 

sinais elétricos com intensidade suficiente para serem processados em um sistema 

de contagem ou espectroscopia. A fotomultiplicadora possui um fotocatodo que 

transforma os sinais luminosos (poucos, da ordem de centenas) decorrentes da 

cintilação em sinais elétricos, que são direcionados a um arranjo de vários dinodos, 

responsáveis por multiplicar esses sinais. Cada dinodo acelera um elétron do 

estágio anterior, que ao colidir com a superfície do dinodo, gera mais elétrons. Esses 

elétrons são então acelerados para o próximo estágio, repetindo o processo. Um 

conjunto típico de dinodos pode produzir um número de elétron na ordem de  107 a 

109 elétrons. Essa carga é suficiente para gerar um pulso de tensão quando coletada 

no anodo da fotomultiplicadora, proporcional ao pulso inicial gerado (Figura 7). Esse 

fenômeno é conhecido como emissão secundária (Tauhata et al., 2013). 
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Figura 7. Esquema de funcionamento de uma fotomultiplicadora 

 

Fonte: Tauhata, 2013 

 

 Os pulsos para cada energia são então enviados a um canal referente a sua 

energia, formando um espectro como o de número de contagens em função da 

energia, conforme visto na Figura 8. Quanto maior for as flutuações de contagem, 

maior será a largura a meia altura (FWHM, do inglês Full Width at Half Maximum) do 

pico e, consequentemente, pior a resolução em energia (Knoll, 2010). A Figura 8 

demonstra um exemplo do que é FWHM e sua importância no cálculo da resolução 

em energia de um detector, onde H0 é a altura média do pulso.  
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Figura 8. Definição da resolução em energia de um detector 

 

Fonte: Adaptado de Knoll, 2010 

 

A largura em questão é um reflexo das flutuações significativas observadas 

de um pulso para o outro, mesmo quando a mesma quantidade de energia é 

depositada no detector em cada evento. Se houver uma redução nessas flutuações, 

a largura da distribuição correspondente diminuirá, fazendo com que o pico se torne 

mais agudo. A habilidade de uma medição específica em discernir detalhes sutis na 

energia da radiação incidente melhora à medida que a largura da função de resposta 

diminui. Assim, quanto maior a resolução de energia, mais eficaz o detector será em 

diferenciar duas radiações cujas energias são muito próximas (Knoll, 2010). Na 

Figura 5 é possível ver a diferença da resolução entre um detector cintilador NaI(Tl) 

e um detector semicondutor HPGe, sendo este último superior em termos de 

resolução, embora tenha uma menor eficiência de contagem. 

A eficiência de contagem de um detector, por sua vez, está relacionada a 

quanto um detector é capaz de “ver” cada partícula ou fóton que interage em seu 

meio. Partículas carregadas normalmente interagem em toda sua trajetória no 

volume sensível do detector, produzindo sinais suficientes para registro. Assim, é 

bem possível obter um detector que detecte cada partícula carregada incidente. 
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Dessa forma considera-se que o detector tem uma eficiência de contagem de 100% 

(Knoll, 2010). Ao contrário das partículas carregadas, fótons precisam sofrer 

interações a um nível de significância considerável para possibilitar sua detecção e, 

uma vez que eles podem percorrer grandes distâncias entre cada interação, os 

detectores não costumam ser 100% eficientes (Knoll, 2010). 

A eficiência de um detector pode ser definida de duas formas: eficiência 

intrínseca e eficiência absoluta. A eficiência intrínseca está relacionada aos fatores 

intrínsecos do detector, como o tamanho do cristal do iodeto de sódio, seu nível de 

pureza e eficiência na coleção de luz, por exemplo. Ela pode ser descrita como: 

 

𝜀𝑖𝑛𝑡 =  
𝑛ú𝑚𝑒𝑟𝑜 𝑑𝑒 𝑐𝑜𝑛𝑡𝑎𝑔𝑒𝑛𝑠 𝑟𝑒𝑔𝑖𝑠𝑡𝑟𝑎𝑑𝑎𝑠

𝑛ú𝑚𝑒𝑟𝑜 𝑑𝑒 𝑟𝑎𝑑𝑖𝑎çõ𝑒𝑠 𝑖𝑛𝑐𝑖𝑑𝑒𝑛𝑡𝑒𝑠 𝑛𝑜 𝑑𝑒𝑡𝑒𝑐𝑡𝑜𝑟
                           (Equação 3) 

 

A eficiência absoluta tem ligação com a geometria da medição, a fonte de 

radiação e o ambiente. A distância do emissor, o tipo de feixe emitido (seja radial ou 

colimado), o ambiente entre o detector e a fonte emissora, além dos fatores que 

impactam a eficiência intrínseca do detector, são todos elementos que influenciam 

essa eficiência (Knoll, 2010). Ela pode ser definida como: 

 

     𝜀𝑎𝑏𝑠 =  
𝑛ú𝑚𝑒𝑟𝑜 𝑑𝑒 𝑐𝑜𝑛𝑡𝑎𝑔𝑒𝑛𝑠 𝑟𝑒𝑔𝑖𝑠𝑡𝑟𝑎𝑑𝑎𝑠

𝑛ú𝑚𝑒𝑟𝑜 𝑑𝑒 𝑟𝑎𝑑𝑖𝑎çõ𝑒𝑠 𝑒𝑚𝑖𝑡𝑖𝑑𝑎𝑠 𝑝𝑒𝑙𝑎 𝑓𝑜𝑛𝑡𝑒
                             (Equação 4) 

 

 

Calibração em energia  

 A calibração em energia de um detector cintilador é a correlação entre os 

sinais elétricos produzidos pelo detector e as energias dos fótons ou partículas que 

interagem com ele. Essa calibração está ligada a resolução em energia desse 

detector e sua capacidade de discriminar diferentes energias dos fótons.  
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Utilizando-se de fontes de calibração conhecidas com energias bem definidas 

e diferentes dentro da faixa de energia pretendida, é feita a relação da energia do 

fóton no canal central do fotopico, por meio de uma curva de calibração linear, 

levando também em consideração o FWHM (Figura 9). O sistema de detecção do 

NaI(Tl) utilizado nesse trabalho, possui 1024 canais com 3 keV em cada canal, 

cobrindo uma faixa de detecção de 3 a 3072 keV.  

 

Figura 9. Curva de eficiência de calibração em energia 

 

Fonte: Adaptado de Al Oraini, 2018 

Calibração em eficiência   

O objetivo das técnicas de calibração da eficiência de detecção em sistemas 

de monitoramento in vivo é gerar coeficientes de calibração (CC). Esses fatores 

viabilizam a conversão da taxa de contagem, obtida durante a medição, em um valor 

que represente a atividade presente no órgão ou tecido em análise. Tal conversão 

se dá em virtude da relação direta entre a taxa de contagem e a atividade. Assim, a 

calibração da eficiência possibilita estabelecer essa relação para as condições de 

medição, considerando a geometria, a distribuição do radionuclídeo no corpo, as 
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características do sistema de medição e a atenuação da radiação ao atravessar os 

tecidos (Dantas, 1998). A eficiência de contagem refere-se à razão entre o número 

de fótons detectados em relação ao número de fótons emitidos pela fonte de 

radiação.  

Existem três métodos de calibração: utilizando fontes pontuais, com 

voluntários ou pacientes e calibração com fantomas antropomórficos e 

antropométricos. Esta última sendo a mais utilizada, uma vez que a utilização de 

voluntários e pacientes demanda um extenso e cuidadoso planejamento e 

permissão dos conselhos e ética e a calibração com fontes pontuais fica restrita a 

medição de um único radionuclídeo por vez, além de expor o indivíduo a radiação 

externa (IAEA, 1996a).  

Como um sistema de medição precisa ser calibrado com padrões de medidas 

e condições semelhantes às do corpo humano, nos Contadores de Corpo Inteiro 

(CCI), o referencial adotado é conhecido como simuladores físicos antropomórficos. 

Estes simuladores buscam replicar de forma bastante aproximada os órgãos de 

interesse, permitindo a determinação da eficiência de detecção para diversos 

radionuclídeos em diferentes geometrias de contagem. Constituem-se de estruturas 

artificiais com a forma e dimensões do corpo humano ou de órgãos específicos, nos 

quais são inseridas atividades conhecidas de radionuclídeos necessárias para a 

calibração do equipamento (Dantas, 1998). 

Não existe uma padronização ou uniformidade nas técnicas de calibração; há 

uma variedade de simuladores desenvolvidos e empregados globalmente (ICRU, 

1992). No entanto, uma grande parte dos pesquisadores na área de monitoramento 

in vivo defende a necessidade de padronização dessas técnicas (Kramer & Inn, 

1991). 
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 3.3.1.4  Simuladores físicos ou fantomas  

 Os fantomas de calibração para os sistemas de monitoração in vivo podem 

ser de corpo inteiro ou de órgãos e regiões específicas de acordo com a 

necessidade, como por exemplo, cabeça e tórax. O mais utilizado e disseminado 

simulador de corpo inteiro é o BOttle Manikin ABsorption (BOMAB) phantom (ANSI, 

1999), ele constitui-se de um conjunto de frascos em polietileno de formas cilíndricas 

ou elípticas que assumem altura e peso de indivíduos de referência da ICRP. Esses 

frascos são então preenchidos com distribuição homogênea em uma solução 

contendo atividades conhecidas de radionuclídeo para medição. Existem 

normalmente uma família desses simuladores, representando desde bebês a 

adultos. Pesquisadores ao redor do mundo também adaptam esses fantomas para 

representar o padrão de seu país (Manohari et al., 2022). 

Seguindo a mesma linha, existem os fantomas modulares UP-02T, REMCAL 

(Kovtun et al., 2000) e Emma (Lebacq et al., 2011), com inserção dos radionuclídeos 

em forma sólida, como hastes, nas cavidades dos fantomas. A Figura 10 mostra 

alguns exemplos desses fantomas físicos. Mais recentemente, Paiva et al. (2017) 

desenvolveram o chamado PET-BOMAB, um fantoma de corpo inteiro masculino de 

1,70 m e 70 kg baseado no BOMAB para calibração do Laboratório de Dosimetria 

Interna do CDTN. 
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Figura 10. Simuladores físicos BOMAB, EMMA e UP-02T 

 

A) BOMAB; B) Família de fantomas EMMA; C) Família de fantomas UP-02T 

Fonte: Nuclear Technologies, Inc.; Kovtun et al., 2000; Lebacq et al., 2011 

 

Em casos de calibração específicas de órgãos, existem fantomas específicos 

e mais elaborados dessas áreas anatômicas. Um fantoma comercial bem 

estabelecido no qual diversos outros foram baseados nele é o simulador de tórax 

masculino norte-americano do Laboratório Nacional Lawrence Livermore (LLNL), 

nos EUA. Detalhadamente possui caixa torácica, pulmões, linfonodos pulmonares 

principais e várias camadas torácicas de diferentes espessuras (Griffith et al., 1979; 

Newton et al., 1985).  

 Vital et al (2019) desenvolveram com sucesso um fantoma antropomórfico de 

cabeça para calibração do sistema contador de corpo inteiro utilizando tecido 

equivalente com matriz a base de ágar-ágar. Em 2021, Moratelli et al (2021) 

desenvolveram, por meio de impressão 3D, um fantoma de calibração para 

geometria de contagem de tireóide.  

 Mais fantomas utilizados em calibração de sistemas de monitoração in vivo 

são apresentados na Tabela 4. Se tratando de fantomas de corpo inteiro para 

calibração desses sistemas, eles ainda correspondem pouco ao formato de traços 

humanos reais. Fantomas de corpo inteiro anatomicamente precisos oferecem uma 

A) 
B) 

C) 
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abordagem promissora para aprimorar metodologias de calibração, facilitando uma 

simulação mais precisa da forma humana e reduzindo discrepâncias de medição. 

 

Tabela 4. Simuladores aplicados em calibração de sistemas de monitoração in vivo 

Simulador Geometria Referência 

BOMAB Body Corpo Inteiro (ANSI, 1999) 

Americium Body Corpo Inteiro (Palmer et al., 1985) 

Hammersmith Body Corpo Inteiro (Bewley, 1988) 

RISTH Block Body Corpo Inteiro (AN. Kovtun et al., 1990) 

The Phantom Laboratoy REMAB 

Body 
Corpo Inteiro (Hankins, 1968) 

The Phantom Laboratory 

REMCAL Body 
Corpo Inteiro (ICRU, 1992) 

BRMD Thyroid Tireóide (Gamarnk et al., 1991) 

IAEA/ANSI Thyroid Tireóide (IAEA, 1962) 

KKH Thyroid Tireóide 
(Nishizawa & Maekoshi, 

1990) 

RSD Thyroid Tireóide (ICRU, 1992) 

Seattle Thyroid Tireóide (ICRU, 1992) 

IRH Torso Torso (Dolguirev et al., 1973) 

JAERI Torso Torso (Shirotanl, 1988) 

Livermore Torso Torso (Griffith et al., 1979) 

NRPB Torso Torso (Fry & Sumerling, 1982) 

Winfrith Torso Torso (Speight et al., 1964) 

Fonte: Adaptado ICRU, 1992 

 

3.3.2   Tecido substitutos para desenvolvimento de fantomas  

Por definição, um tecido substituto é qualquer material um tecido humano 

específico em relação a um conjunto de características físicas, como por exemplo, 

as interações da radiação no tecido e as grandezas dosimétricas de interesse do 
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tecido. A escolha das características físicas dependerá da sua aplicação (ICRU, 

1989). 

Para caracterização dos tecidos reais e os substitutos no que diz respeito às 

interações da radiação, o transporte de radiação de partículas primárias e 

secundárias na faixa de energia de interesse devem ser considerados. No geral, 

esses são os coeficientes de interação avaliados: seções de choque para partículas 

carregadas e não carregadas; coeficientes de atenuação de linear e mássico, e 

coeficiente de absorção de energia para partículas sem carga; e stopping power 

mássico total, transferência de energia linear e poder de espalhamento mássico para 

partículas carregadas (ICRU, 1989). 

A escolha da composição de um tecido substituto para um simulador baseia-

se na composição do tecido corporal que se pretende simular e nas características 

do campo de radiação. Não existe um composto químico que reproduza 

precisamente a composição atômica do tecido corporal (White, 1974, 1978). Assim, 

os tecidos substitutos são frequentemente formulações de misturas projetadas para 

apresentar propriedades de interação com a radiação semelhantes às do tecido 

corporal, em vez de replicar sua composição atômica, atendendo às necessidades 

específicas da aplicação. A avaliação da adequação de um determinado substituto 

envolve a comparação das características relevantes de interação com a radiação e 

das densidades de massa entre o tecido corporal e o substituto (ICRU, 1989). 

Os critérios de seleção para tecidos substitutos variam de acordo com o tipo 

de simulador empregado e sua finalidade. No caso de um simulador homogêneo, a 

composição do tecido substituto não é tão crítica; o material precisa apenas possuir 

uma densidade de massa aproximada, dentro da margem de 10%, e ser 

relativamente isento de elementos com número atômico (Z) superior a 20 para evitar 

a produção de raios X fluorescentes. Muitos tipos de plásticos, sistemas de resina 

epóxi e tecido substitutos líquidos à base de água atendem a esses requisitos 

(ICRU, 1989). 
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3.4   SIMULAÇÃO COMPUTACIONAL COM MÉTODO MONTE CARLO 

O Método de Monte Carlo (MMC) é uma ferramenta versátil capaz de abordar 

problemas de qualquer nível de complexidade, destacando-se especialmente na 

física das radiações. Ativo nesse cenário, promovendo o avanço e a aplicação 

dessas técnicas em benefício da comunidade científica e da sociedade em geral. 

O uso do MMC em códigos computacionais para o transporte de partículas 

são ferramentas amplamente utilizadas nas áreas da física nuclear, física médica, 

medicina, astrofísica, proteção radiológica e segurança nuclear. Essa abordagem 

baseia-se na aplicação de métodos matemáticos e estocásticos para calcular o 

comportamento de partículas subatômicas ou macroscópicas em um determinado 

meio (Kulesza et al., 2022; Paixão & Fonseca, 2022). Essas simulações têm como 

objetivo fundamental compreender o movimento, a interação e a propagação de 

partículas através de materiais ou ambientes complexos. O método de Monte Carlo, 

nomeado em referência ao famoso cassino de Monte Carlo, utiliza números 

aleatórios para resolver problemas determinísticos através da geração de múltiplas 

amostras estatísticas (Paixão & Fonseca, 2022). Na área da física das radiações, a 

análise dosimétrica é rotineiramente conduzida por meio de diferentes códigos 

computacionais de renome, todos eles empregando o Método Monte Carlo como 

algoritmo-base para suas simulações. Alguns exemplos incluem MCNPX, MCNP6, 

EGSnrc, PENELOPE, TOPASnBio e GEANT4, FLUKA, PHITS, entre outros.  

O MCNP (do inglês, Monte Carlo N-Particle Transport Code) é um código 

conceituado e amplamente utilizado em modelagem e simulações de transporte de 

partículas. Desenvolvido em 1977 pelo Los Alamos National Laboratory, nos 

Estados Unidos, ele é uma ferramenta fundamental em diversos campos científicos. 

Sua versatilidade permite modelar diferentes tipos de partículas, como nêutrons, 

fótons e elétrons, em uma vasta faixa de energias (Kulesza et al., 2022). Uma das 

grandes vantagens do MCNP é sua capacidade de criar modelos geométricos 

detalhados e complexos, possibilitando a representação precisa de sistemas reais. 

Esses modelos tridimensionais abrangem desde reatores nucleares até 

equipamentos médicos, como PET scans e procedimentos de radioterapia. Além 
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disso, o MCNP é frequentemente utilizado para projetar e aprimorar blindagens de 

radiação, garantindo a segurança em instalações nucleares, laboratórios de 

pesquisa e aplicações médicas (Alloni et al., 2014; Solberg et al., 2001). O código 

considera uma ampla gama de processos físicos, incluindo espalhamento, absorção, 

fissão e produção de radiação secundária, oferecendo resultados precisos quando 

configurado e aplicado corretamente (Kulesza et al., 2022). 

Na dosimetria interna, o MCNP desempenha um papel importante em várias 

aplicações, como por exemplo, na dosimetria em terapia com radionuclídeos, 

simulação e cálculo da distribuição de doses provenientes de fontes de radiação 

interna, permitindo analisar como a radiação se dispersa nos órgãos e tecidos 

(Solberg et al., 2001). Em ambientes ocupacionais onde há exposição a materiais 

radioativos, o MCNP é utilizado para calcular doses absorvidas por trabalhadores, 

auxiliando na implementação de medidas de proteção radiológica (Mendes, 2017). 

No campo da medicina nuclear, o MCNP é empregado para analisar doses de 

radiação resultantes de procedimentos diagnósticos, como tomografia por emissão 

de pósitrons (PET) e cintilografia (Yoriyaz et al., 2001). Ao simular a interação das 

partículas emitidas por radionuclídeos com os tecidos e órgãos do corpo, o MCNP 

possibilita o cálculo das doses absorvidas em diferentes regiões anatômicas. Essas 

simulações detalhadas visam avaliar riscos à saúde e planejar tratamentos médicos, 

assegurando a administração segura e eficaz de doses terapêuticas. 

Em 2016, surgiu o MCMEG (do inglês, Monte Carlo Modeling Expert Group), 

um grupo dedicado a trazer novos estudos e ampliar conhecimentos dialogando com 

a comunidade científica e conduzindo uma ampla gama de pesquisas no campo das 

ciências das radiações. Composto por especialistas altamente capacitados em 

modelagem e simulação utilizando o método matemático de Monte Carlo, o MCMEG 

tem como principal objetivo contribuir para as áreas de dosimetria e proteção 

radiológica. O grupo se destaca por sua missão de promover cursos, exercícios de 

intercomparação, experimentos e apoio científico na área da modelagem e 

simulação computacional (in Silico) por meio do método de Monte Carlo em várias 

disciplinas das engenharias nucleares e ciências das radiações. 
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3.4.1 Modelagem e simulação computacional de sistemas de monitoração individual. 

Em aplicações em sistemas de monitoração in vivo, mais especificamente na 

calibração em eficiência de contadores de corpo inteiro, ele é aplicado calculando a 

melhor geometria de contagem (Bento et al., 2012; Ferreira et al., 2023; Fonseca et 

al., 2014; Fonseca et al., 2014), na criação de fantomas antropomórficos virtuais e 

analisando correções de eficiência de detectores individuais (Shypailo & Ellis, 2011), 

comparação entre a eficiência de vários fantomas computacionais (Ferreira et al., 

2023; Fonseca et al., 2014), calibração virtual de sistemas contadores de corpo 

inteiro (Park et al., 2021), comparação entre métodos de calibração (Ródenas et al., 

2005), validação de fantomas comparando resultados computacionais e 

experimentais, entre outros (Pacheco, 2023; Park et al., 2023).  

O processo de calibração com códigos de Monte Carlo normalmente se inicia 

com a modelagem detalhada do sistema contador de corpo inteiro, levando em 

conta suas características físicas, como os materiais dos detectores e a geometria 

de contagem do sistema com a inserção de fantomas computacionais desenvolvidos 

exatamente para esse fim. Com base nesse modelo, o código realiza simulações de 

transporte de radiação, onde é possível inferir como as partículas de radiação 

emitidas por fontes internas ao fantoma, com origem determinada no software, 

interagem com os detectores do contador. 

É então calculada a resposta do contador à radiação incidente, estimando a 

eficiência de detecção para várias energias e tipos de radiação. Esses cálculos são 

comparados com dados experimentais de calibração do contador. A partir dessa 

comparação, é possível ajustar os parâmetros do modelo do código para que os 

resultados simulados se aproximem dos valores reais medidos experimentalmente. 

Após a calibração, o modelo do código computacional pode ser validado por meio de 

novas medições experimentais. Se os resultados da simulação se mostrarem 

consistentes com as medições reais, o modelo é considerado válido, permitindo 

estimar a eficiência do contador em diferentes situações de exposição à radiação. 
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De modo geral, códigos de simulação de transporte de partículas 

desempenham um papel importante na calibração em eficiência de contagem dos 

contadores de corpo inteiro, além de diversos outros fins, fornecendo um meio 

preciso e detalhado para simular como esses dispositivos respondem à radiação 

emitida pelo corpo humano ou por fontes radioativas. Isso contribui 

significativamente para garantir a precisão e a confiabilidade desses dispositivos na 

medição e monitoramento da radiação. O MCNP, como citado, já é um código bem 

estabelecido e validado para essas aplicações. 

 

3.5   TECNOLOGIA DE IMPRESSÃO 3D 

A técnica de impressão 3D é um processo que permite a criação de objetos 

tridimensionais por meio da deposição camada por camada de materiais como 

plásticos, metais, cerâmicas e compostos especiais. Essa tecnologia oferece uma 

variedade de benefícios e aplicações em diversos setores, incluindo a área médica e 

radiológica. Os principais tipos de impressão 3D são Fused Deposition Modeling 

(FDM), no qual um filamento de material termoplástico aquecido que é depositado 

em camadas, solidificando-se conforme é resfriado. A estereolitografia (SLA, do 

inglês Stereolithography), no qual são utilizadas resinas fotossensíveis que são 

endurecidas por meio de luz ultravioleta, camada por camada, para formar o objeto 

desejado. Semelhantemente ao SLA, o processo de luz digital, ou DLP, utiliza luz 

para solidificar resinas fotossensíveis, porém com um processo que expõe uma 

camada inteira de uma vez, em vez de ponto a ponto como no SLA. 

A capacidade da impressão 3D de criar modelos anatômicos complexos e 

dispositivos personalizados tem impactado positivamente a área médica. Ela permite 

a personalização de dispositivos implantáveis, treinamento cirúrgico, diagnóstico 

minimamente invasivo, pesquisa médica e modelos de doenças, levando 

potencialmente a implantes personalizados e sob demanda e produção de órgãos de 

engenharia de tecidos (Nagarajan et al., 2018).  
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Na área da medicina radiológica, a técnica de impressão 3D é aplicada no 

desenvolvimento de modelos antropomórficos para controle de qualidade, 

otimização de protocolos, planejamento de tratamento e treinamento de técnicos de 

raios X e radiologistas (Bliznakova et al., 2020). Além de impactar no 

desenvolvimento de simuladores para controle de qualidade em tomografia 

computadorizada, PET (do inglês, Positron Emission Tomography), SPECT (do 

inglês, Single Photon Emission Computed Tomography), ressonância magnética e 

ultrassonografia (Filippou & Tsoumpas, 2018). No mais, diversos fantomas têm sido 

desenvolvidos para dosimetria das radiações, principalmente em radioterapia 

(Fahimian et al., 2023; Higgins et al., 2022; Hong et al., 2019; Pereira et al., 2022).  

No que tange à área de monitoração in vivo, Moratelli et al (2021) fabricaram 

um fantoma antropomórfico de tireoide para calibração de geometria de contagem 

para tireoide. Porém, a disponibilidade de estudos em literatura acerca da aplicação 

dessa técnica em fantomas de calibração em CCI ainda é escassa.  
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3 METODOLOGIA 

Neste capítulo, serão delineados os procedimentos metodológicos adotados 

para o (1) desenvolvimento do fantoma em impressão 3D, (2) o estudo e a análise 

da atenuação do material tecido equivalente proposto e a modelagem e (3) 

simulações computacionais para avaliar a viabilidade e a susceptibilidade de uso do 

fantoma desenvolvido. Este trabalho foi inteiramente desenvolvido no Laboratório de 

Dosimetria Interna do Centro de Desenvolvimento da Tecnologia Nuclear em Minas 

Gerais, dentro do projeto de pesquisa “PPA 0006.27 - Desenvolvimento de Sistemas 

Dosimétricos” da instituição, coordenado pelo professor Dr. Bruno Melo Mendes.   

Inicialmente, serão detalhados os passos seguidos para o projeto e fabricação 

do fantoma físico RFPID (do inglês, Reference Female Phantom for Internal 

Dosimetry) em impressão 3D. Isso incluirá o design do modelo a ser impresso, a 

seleção do material, os parâmetros de impressão utilizados e os processos e 

análises de pós-processamento. Em seguida, será descrita a metodologia 

empregada para estudar e avaliar a atenuação do material proposto, a gelatina 

balística, em comparação com tecido muscular humano. Isso envolve a realização 

de testes de atenuação usando fontes de radiação específicas e conhecidas, 

medição e cálculo dos coeficientes de atenuação e comparação com dados de 

referência do tecido humano. Para concluir o capítulo, serão discutidos os métodos e 

ferramentas computacionais utilizados para simular um cenário de monitoração com 

o simulador RFPID. Isso compreende a parte da modelagem e simulação do 

fantoma no ambiente de monitoração e a aplicação das condições relevantes e de 

interesse para estudar os parâmetros de eficiência de contagem.  

 

3.1   DESENVOLVIMENTO DO FANTOMA  

O fantoma físico Reference Female Phantom for Internal Dosimetry foi 

desenvolvido com base no Reference Computational Phantom Adult Female 

(RCP_AF) da ICRP-110 (ICRP, 2009). De acordo com a ICRP, considera-se uma 

mulher de referência como tendo 160 cm de altura de 60 kg de massa. O RCP_AF é 
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um fantoma computacional desenvolvido a partir de uma sequência de imagens de 

tomografia computadorizada de uma mulher de 43 anos de idade, com 163 cm de 

altura e com 59 kg de massa. A Tabela 5 descreve algumas características do 

RCP_AF, demais informações acerca do modelo podem ser encontradas na ICRP 

Publication 110 e seus anexos (ICRP, 2009). 

 

Tabela 5. Principais características do RCP_AF/ICRP 

Característica RCP_AF 

Altura (m) 1,63 

Massa (kg) 60,0 

Número de voxels de tecido 3.886.020 

Espessura de corte (altura do voxel, mm) 4,84 

Dimensão do voxel no plano XY (mm) 1,775 

Volume do voxel (mm3) 15,25 

Número de colunas 299 

Número de linhas 137 

Número de cortes 346 (+2)* 

* Cortes adicionais de pele no início e fim  

Fonte: Adaptado de ICRP, 2009 

 

O RCP_AF é disponibilizado em formato de texto, com a extensão .DAT. No 

contexto da criação do modelo físico do RFPID, foi necessária a conversão desse 

formato de arquivo para um formato de imagem com extensão .RAW. Esse processo 

foi viabilizado por meio da utilização de um programa desenvolvido em linguagem 

C++ (Mendes, 2017), de autoria do Prof. Dr. Bruno Melo Mendes do CDTN/CNEN. 

O referido programa possibilitou a conversão dos dados de texto em um 

conjunto composto por 350 imagens axiais com extensão .RAW. 

Subsequentemente, essas imagens foram submetidas a manipulações mediante o 

emprego de ferramentas de software especializado, tais como ImageJ®, GIMP®, 

Amide®, 3D Slicer® e FreeCAD®. Cabe ressaltar que o RFPID representa um 

fantoma de corpo inteiro que apresenta uma estrutura interna oca, destinada a ser 
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preenchida com material tecido equivalente (MTE). O processo de desenvolvimento 

do RFPID será exposto a seguir.  

Visando adequar o modelo às capacidades de impressão das impressoras 

3D, este foi dividido em múltiplas partes. Inicialmente, o software ImageJ® (Rasband, 

2016) foi utilizado para extrair imagens axiais do arquivo .RAW de corpo inteiro, que 

foram posteriormente separadas em duas partes (lados direito e esquerdo do corpo). 

As imagens resultantes foram então convertidas em um arquivo binário. Toda a 

informação de heterogeneidade do tecido foi perdida nesta etapa e apenas a forma 

foi conservada. Após a binarização, as duas imagens apresentaram apenas duas 

cores: preto (valor 255), indicando pixels de tecido, e branco (valor 0), representando 

o ar circundante. Posteriormente a escala de pixels foi ajustada de 1,775x1,775x4,84 

mm³ para 1x1x1 mm³ para melhorar a resolução da imagem. Além disso, técnicas de 

redução de bordas foram implementadas através da aplicação de um efeito 3D 

Gaussian Blur para suavizar as superfícies do fantoma. A imagem resultante do 

Gaussian Blur precisou ser binarizada mais uma vez, pois o efeito de desfoque 

gerou voxels com múltiplos tons de cinza (valores entre 1 e 254). Posteriormente, 

foram obtidas 16 imagens dividindo os cortes axiais do fantoma em oito segmentos 

de cada lado: sete com 20 cm de altura e um com 29,4 cm. 

Para atender aos requisitos de um simulador físico usado para calibração do 

sistema de monitoração in vivo, cada uma das 16 partes deve ser oca para permitir o 

preenchimento no futuro com uma fonte radioativa certificada. Assim, cada parte 

teve que ser dividida em duas estruturas de subpartes: uma estrutura oca com uma 

extremidade fechada e a sua respectiva tampa. A casca da estrutura vazada foi 

gerada utilizando o software ImageJ®. A imagem original de cada parte foi 

sistematicamente reduzida através de sete iterações de erosão de imagem, 

removendo 7 mm de “tecido”. A partir daí a imagem original da peça foi subtraída da 

imagem erodida, resultando em uma estrutura de casca com 7 mm de espessura. 

Porém, algumas descontinuidades (buracos ou paredes muito finas) foram 

observadas em regiões com curvas mais angulares. Para selar esses furos foi 

executada uma operação de Reslice, que consiste na rotação de 90° das imagens. 

Os procedimentos de erosão e subtração das etapas anteriores foram executados 
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na imagem que passou pelo processo de Reslice na etapa anterior, resultando em 

uma segunda casca da mesma peça. A segunda casca também apresentava 

buracos, mas em locais diferentes. A operação “Image Calculator = OR” combinou a 

primeira e a segunda imagens da casca, resultando em uma casca completamente 

vedada com 7 mm de espessura mínima de parede. 

Utilizou-se o software GIMP® (Lecarme & Delvare, 2012) para construir, em 

cada uma das 16 peças, um canal em forma de U (com 2mm de profundidade e 

1mm de largura) para servir de encaixe fêmea para a tampa. Posteriormente, foi 

criada um encaixe macho em cada tampa. 

As imagens da peça vazada e sua respectiva tampa foram convertidas para 

o formato DICOM utilizando o software ImageJ®. No entanto, as informações da 

escala de voxel são perdidas durante o processo de salvamento. Para resolver isso, 

as escalas de voxel foram redefinidas para 1x1x1 mm³ usando o software AMIDE® 

(Loening & Gambhir, 2003). As peças foram posteriormente convertidas para 

arquivos .STL (estereolitografia) compatíveis com impressoras 3D utilizando o 

software 3D Slicer® (Pieper et al., 2004). Como etapa final no processo de criação 

das tampas, um furo circular foi incorporado para possibilitar a inserção de um funil 

destinado ao preenchimento das peças com material radioativo, utilizando o software 

FreeCAD®. 
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Figura 11. Processo de desenvolvimento do RFPID

 

Esquema do de desenvolvimento do RFPID 3D, com uma peça da cabeça como exemplo. 

Fonte: A Autora 

 

Para a impressão das peças, foram utilizadas duas impressoras 3D Creality 

Ender 5 Plus (Shenzhen Creality 3D Technology CO., LTD, China), que possuem 

uma área de impressão de 350x350x400 mm3 (LxCxA). Elas são impressoras que 

empregam o método FDM (do inglês, Fusion Deposition Modeling) de impressão. O 

filamento utilizado foi o PLA (do inglês, Polylactic Acid) transparente premium 

(3DLab Indústria Ltda., Brasil) devido à sua boa equivalência de atenuação aos 

tecidos moles (Savi et al., 2020, 2021) e é um dos materiais mais fáceis de 

manusear na impressão 3D. Além disso, o PLA é vegetal e biodegradável, o que o 

torna ecologicamente correto.  

Para o fatiamento das peças para impressão, foi utilizado o programa fatiador 

próprio da empresa manufatureira das impressoras, o Creality Cura. Os parâmetros 

de impressão utilizados são descritos na Tabela 6. 
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Tabela 6. Parâmetros de fatiamento para impressão do RFPID 

Parâmetro Valor 

Temperatura de mesa 55 ºC 

Temperatura da extrusora 220 ºC 

Espessura de camada 0.28 mm 

Espessura da camada inicial 0.28 mm 

Espessura de parede 0.8 mm 

Número de camadas de parede 2 

Porcentagem de preenchimento 25% 

Perfil de preenchimento Cúbico 

Velocidade de impressão 85 mm/s 

Velocidade de impressão (camada inicial) 15 mm/s 

Diâmetro bico de extrusão 0.4 mm 

Diâmetro do filamento 1.75 mm 

Fonte: Elaborado pela Autora 

 

Após a impressão de todas as peças e suas respectivas tampas, o que durou 

aproximadamente dois meses, foi utilizado um plástico termoencolhível para unir as 

peças e permitir a visualização do modelo completo. O processo completo, contando 

com o passo-a-passo para a manipulação e design do fantoma, encontra-se no 

Apêndice I deste trabalho. 

 

3.4.1  Pós-processamento 

Após a impressão, testes de materiais para impermeabilização das peças e 

vedação do encaixe entre peça e tampa foram necessários. Foram testados dois 

tipos de impermeabilizantes, com três aplicações externas e internas na peça: 

RevestikTM Emborrachamento Spray Preto (TBR Adesivos e Selantes LTDA) e 

resina epóxi (Real Epóxi). Para a vedação, foram selecionados dois tipos de colas: 

Adesivo de Poliuretano Preto (Orbi Química) e Cola de Silicone Acética (Tekbond – 

Saint-Gobain). O teste consistiu na observação de existência de vazamentos nas 

peças após a inserção de água, marcada com o traçador de fluxo uranina. A uranina 
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é um tipo de corante amarelo que permite a visualização de possíveis vazamentos e 

rachaduras em materiais onde tem um fluxo, como o de água, por exemplo. 

O acompanhamento da perda de massa através do tempo foi realizado 

durante um período de aproximadamente três meses, utilizando uma Balança de 

Precisão Bel 0,01g 2,200g (Bel Engineering®).  

 

4.2    FILAMENTO DE IMPRESSÃO 

4.2.1 Estudo da densidade do material 

A densidade dos objetos impressos em 3D pode variar com base no filamento 

e nas técnicas de enchimento utilizadas durante a impressão (Savi et al., 2021; 

Villani et al., 2020). A densidade do material utilizado na produção de um fantoma 

físico é um parâmetro importante que afeta as propriedades de atenuação do objeto. 

Assim, para examinar a densidade do PLA após o processo de impressão, dez 

objetos de teste foram impressos em 3D com geometrias cúbicas e paralelepípedas. 

Os parâmetros de impressão aplicados na fabricação do fantoma, conforme 

descritos na Tabela 6, foram os mesmos utilizados para impressão destes objetos 

de teste. Os objetos cubo tinham arestas medindo 0,35 cm, 0,5 cm e 0,7 cm. Por 

outro lado, os objetos em forma de paralelepípedo eram diferentes em tamanho, 

mas cada um tinha pelo menos uma borda de 0,7 cm, que é a espessura mínima da 

parede das partes físicas do fantoma descritas posteriormente. 

Para determinar a densidade dos objetos, foi utilizada a fórmula da Equação 5: 

 

𝜌 =
𝑚

𝑣
,      (Equação 5) 
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onde, 𝜌 indica a densidade, 𝑚 representa a massa e 𝑣 indica o volume. Para 

garantir a exatidão dos nossos cálculos de densidade, cada peça impressa foi 

submetida a cinco pesagens utilizando uma balança analítica Mettler Toledo 

ME204/A (Mettler Toledo Indústria e Comércio LTDA, Brasil) para ter em conta 

eventuais erros de medição. 

Um segundo método foi usado para calcular a densidade média de PLA no 

simulador físico impresso. A massa do fantoma impresso (vazio, ou seja, com ar em 

suas cavidades) foi medida em uma balança de peso Welmy (W 200). O volume de 

PLA do fantoma foi calculado a partir da imagem 3D do modelo usando um 

programa C++ interno. A densidade foi obtida a partir do quociente entre a massa do 

modelo vazio e o volume do PLA utilizando a Equação 4. 

4.2.2 Estudo da atenuação do PLA 

Para estudo da atenuação do PLA, foram impressas cinco placas com 

dimensões de 10x10x1 cm3, seguindo o mesmo padrão de preenchimento (25%) e 

demais parâmetros de impressão do RFPID, conforme descrito na Tabela 6. Para o 

teste, foi montado um setup com uma fonte pontual de Radio-226 e um detector 

NaI(Tl) 3” x 3”, selados com camadas de chumbo para diminuir interferência da 

radiação ambiente. O feixe foi colimado também com chumbo com um furo de 

passagem de 8 mm de diâmetro. A distância entre a saída do feixe e a face do 

detector foi de 15 cm. Um desenho esquemático do setup é demonstrado na Figura 

12.  
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Figura 12. Desenho esquemático do setup de teste de atenuação

À esquerda, o posicionamento da fonte de Radio-226 e a colimação e blindagem de chumbo. À 

direita, o detector NaI(Tl). Entre eles, um exemplo do posicionamento das amostras. Detalhes de 

dimensões são descritas na imagem. 

Fonte: Elaborado pela Autora 

 

Foram colocadas as cinco placas entre a fonte e o detector e as aquisições do 

espectro foram feitas utilizando o GenieTM 2000 Spectroscopy Software (Canberra 

Industries, Inc., Parkway, Meriden, Connecticut, USA). As placas foram então 

removidas uma a uma, de forma a variar a espessura do material, e o processo de 

aquisição repetidos para cada espessura. O cálculo do coeficiente de atenuação 

linear seguiu a Equação 2, da lei de atenuação linear citada no Capítulo 3.2.2: 

 

𝐼 = 𝐼𝑜 ∙ 𝑒−𝜇𝑥      (Equação 2) 

  

onde, 𝐼 representa a intensidade final do feixe de fótons após passar pelo 

material, 𝐼𝑜 é a intensidade inicial do feixe, μ é o coeficiente de atenuação linear e 𝑥 

é a espessura do material. Aqui, para cada energia, 𝐼𝑜, foi considerada a área do 

pico sem nenhuma amostra e, 𝐼, a área do pico obtida com uma amostra de 

espessura 𝑥.  
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Por se tratar de uma análise de espectro, os fótons de espalhamento não 

afetam a área do pico em análise, uma vez que sua energia mais baixa é computada 

em outra região do espectro. A Figura 13 apresenta o cenário real do setup de 

experimento. Nela, podem ser vistas exemplos das amostras impressas (A) e uma 

imagem focada do setup real (B).  

 

Figura 13. Setup do experimento de atenuação 

 

Em A) fotografia da vista da maior área da placa, onde é possível observar o padrão de 

preenchimento delas; em B) fotografia da vista lateral do setup de experimento com as cinco placas 

posicionadas. À esquerda, vista da face do detector NaI(Tl), à direita, vista do furo de saída do feixe. 

Fonte: A Autora 

 

Para comparação, os dados de composição do tecido muscular humano 

foram adquiridos por meio da ICRU-44 (ICRU, 1989) e, a partir disso, os coeficientes 

de atenuação mássico do músculo foram obtidos no banco de dados NIST XCOM 

(NIST, 2023) e, a partir deles, o coeficiente de atenuação linear foi determinado. As 

diferenças foram calculadas seguindo a Equação 6 

𝛥 = [
(𝜇𝑚𝑎𝑡𝑒𝑟𝑖𝑎𝑙−𝜇𝑚ú𝑠𝑐𝑢𝑙𝑜)

𝜇𝑚ú𝑠𝑐𝑢𝑙𝑜
] ∙ 100          (Equação 6) 

  

 

A) B) 
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4.3   PRODUÇÃO E TESTES DO GEL BALÍSTICO 

Dois grupos do gel balístico, nominados como Grupo 1 e Grupo 2, com quatro 

amostras cada, foram feitos por meio da seguinte composição:  

 água destilada (68,5%); 

 glicerina (4,1%); 

 gelatina bovina (27,4%).  

Todos os ingredientes foram misturados por aproximadamente 15 minutos a 

90°C até se obter uma mistura uniforme. Foi então interrompido o fornecimento de 

calor e a agitação continuou até a solução atingir 40°C. O gel balístico resultante foi 

distribuído em quatro moldes impressos em 3D, cada um medindo 10x10x2 cm, e 

posteriormente refrigerado a 5°C durante quatro horas para atingir a gelificação 

ideal. 

 

Figura 14. Modelo de amostra pós gelificação 

 

À esquerda, vista superior das quatro amostras e, à direita, a vista frontal. 

Fonte: A Autora 

 

O setup experimental e as aquisições forem feitas exatamente como as 

descritas anteriormente para o PLA no subtópico 4.2.2 deste trabalho. O mesmo 

processo de comparação dos coeficientes com os do músculo foi feito para o gel 

balístico, com o adicional dos materiais polimetilmetacrilato (PMMA) e a água, que 
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são materiais comumente utilizados como tecido-equivalentes no desenvolvimento 

de fantomas. Os dados de composição e densidades desses dois materiais foram 

tirados do compêndio “Data Mining Analysis and Modeling Cell Compendium of 

Material Composition Data for Radiation Transport Modeling” (PNNL, 2021) e os 

coeficientes de atenuação mássico obtidos por meio do software NIST XCOM e, a 

partir deles, os coeficientes de atenuação linear foram determinados a partir da 

Equação 2.  

A partir da composição química encontrada para o gel balístico, os 

coeficientes de atenuação também foram obtidos do NIST XCOM para analisar se 

os resultados experimentais estarão de acordo com os do NIST. A densidade 

mássica do gel balístico (gm.cm-3) foi calculado por meio da Equação 5.  

 

Figura 15. Setup experimental para teste de atenuação do gel balístico 

 

À esquerda, a vista lateral do setup com a folha de chumbo o cobrindo e, à direita a vista superior do 

setup sem a folha de chumbo. 

Fonte: A Autora 

 

Além disso, a consistência do gel, o crescimento microbiano e a perda de 

água foram avaliados qualitativamente em ambiente refrigerado (aproximadamente 

5° C), em temperatura ambiente controlada (23° C) e em temperatura ambiente 

descontrolada (variação de 25° até 38º C) para o Grupo 1. Para o Grupo 2, foi 

realizada a esterilização do material por meio de irradiação gama no Laboratório de 
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Irradiação Gama do CDTN, sendo aplicadas uma dose de 25 kGy em duas amostras 

e 50 kGy em outras duas amostras. Para tal, foi utilizada uma fonte de 60Co com 

atividade de 55971 Ci, com as amostras a uma distância de 56 cm (25 kGy) e 37 cm 

(50 kGy), o tempo de irradiação foi de 24 horas para todas as amostras. Os objetivos 

de avaliação supracitados para o Grupo 1 foram conduzidos para o Grupo 2 em 

temperatura ambiente controlada (23° C).  

4.3.1  Simulação computacional 

 Para avaliar a adequação dos resultados, também foi realizada, com os 

integrantes do grupo MCMEG, simulações computacionais do coeficiente de 

atenuação linear do gel balístico levando em consideração a densidade e 

composição do material. Para isso, o código de Monte Carlo TOPAS versão 3.8 foi 

utilizado (Pearl et al., 2012)  

 Foram consideradas fontes monoenergéticas com as mesmas energias 

avaliadas experimentalmente com o Ra-226, com o setup da lei de atenuação de 

fótons descrito por Paixão e Fonseca (2022). O cartão de registro de resultados 

“Fluência” foi utilizado, os demais parâmetros de transporte seguiram o padrão do 

TOPAS. O número total de partículas simuladas foi 107 com um erro relativo abaixo 

de 1%. As simulações foram rodadas em um computador CPU Intel® i7 9ª geração 3 

GHz e 16 GB de RAM.  

 

4.4   MODELAGEM E SIMULAÇÃO COMPUTACIONAL DO RFPID 

O fantoma computacional de voxel RFPID foi criado a partir das imagens 

utilizadas no processo de impressão 3D do modelo físico, combinando todas as 

imagens e formando o modelo completo (Figura 16A). As dimensões da matriz do 

fantoma foram (178 x 565 x 82) mm³, com tamanho de voxel de (3 x 3 x 3) mm³. A 

imagem .RAW do modelo computacional (Figura 16B) foi traduzida em dados 

compatíveis com o código MCNP através da utilização de um programa C++ interno. 
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Figura 16. Imagens do RFPID 

    

A) Imagem 3D renderizada do RFPID e; B) Corte transversal do modelo computacional. 

Fonte: Elaborado pela Autora 

 

O desenvolvimento do fantoma computacional de voxel envolveu a utilização 

de três materiais: Ácido Polilático (PLA) como filamento para o processo de 

impressão 3D, gel balístico como material de enchimento interno e ar externo do 

ambiente circundante. A composição química do gel balístico foi determinada com 

base na composição de seus componentes e nas proporções utilizadas. A Tabela 7 

descreve as densidades e composições dos materiais empregados na simulação. 

 

 

 

 

 

 

A) B) 
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Tabela 7. Composição elementar e densidade do material utilizado nas simulações. 

Material Densidade (g.cm-3) 
Composição 

Elemento Porcentagem de peso 

PLA (Hamad et al., 
2015) 

0,6* 
H 5,6% 
C 50,0% 
O 44,4% 

    
Gel balístico 

(ChemBK, 2023; 
PNNL, 2021) 

1.11* 
H 9,86% 
C 12,61% 
O 77,52% 

    

Ar (PNNL, 2021) 0,001205 

C 0,012% 

N 75,526% 
O 23,178% 
Ar 1,282% 

*Obtido experimentalmente 

Fonte: Elaborado pela Autora 

 

O modelo computacional de voxel foi inserido no setup do sistema de 

monitoração in vivo do LDI Centro de Desenvolvimento de Tecnologia Nuclear da 

Comissão Nacional de Energia Nuclear (CDTN/CNEN, Brasil) que contém um 

Contador de Corpo Inteiro (CCI). O sistema de monitoramento foi previamente 

modelado e validado por Pacheco (2023). O sistema é equipado com um detector 

cintilador NaI(Tl) de 8” x 4”, posicionado próximo à região abdominal. Este 

posicionamento do detector foi estabelecido em diversas pesquisas como a região 

mais eficiente para contagem (Ferreira et al., 2023; Fonseca et al., 2014; Fonseca et 

al., 2014; Paiva et al., 2016; B. Zhang et al., 2008).  

Para simular a faixa de energia de fótons normalmente investigados em 

sistemas de CCI, fontes isotrópicas de fótons monoenergéticos, variando entre 25 

keV e 3.000 keV, foram misturadas ao material referente ao gel balístico de forma 

uniforme no interior do RFPID. Utilizando o cartão Tally F8 (pulse-hight) do MCNP6.2 

que permite obter como resultado das simulações um espectro de contagem por 

energia ou a altura de pulso do fóton de interesse no volume sensível do detector 

(Ferreira et al., 2023; Fonseca et al., 2014; Fonseca et al., 2014; Mendes et al., 

2016; Paiva et al., 2016). Os dados espectrais foram obtidos em 1.024 canais de 

energia, com 3 keV de energia em cada, o que se assemelha à configuração do 
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detector NaI(Tl) do CCI. Para calcular a eficiência absoluta de cada energia, foi 

determinado o quociente dos pulsos no canal do fotopico por partícula emitida pela 

fonte. 

Para fins de comparação, as simulações realizadas com o RFPID foram 

repetidas utilizando o simulador heterogêneo, em termos de composição tecidual e 

densidades, RCP_AF com a mesma geometria e energias de partícula. A fonte de 

radiação foi distribuída uniformemente por todo o tecido mole do simulador. Os 

cálculos seguiram a mesma metodologia aplicada por Paiva et al (2016). 

Posteriormente, os resultados foram graficamente plotados e a curva de eficiência 

em função da energia para os fantomas computacionais de voxel RFPID e RCP_AF 

foram obtidas. A configuração modelada para ambos os fantomas é mostrada na 

Figura 17. A diferença foi calculada seguindo a Equação 7 abaixo. 

 

𝛥 = [
(𝜀𝑅𝐹𝑃𝐼𝐷−𝜀𝑅𝐶𝑃𝐴𝐹

)

𝜀𝑅𝐶𝑃𝐴𝐹

] ∙ 100     (Equação 7) 

 

onde ε representa a eficiência absoluta do detector. 

Para a simulação, o código MCNP6.2 foi executado em um DELL XPS 8700, 

CPU Intel® Core™ i7-4790 a 3,6 Hz, 16 GB de RAM, Windows 8.1 Pro x64. As 

bibliotecas utilizadas para dados de sessão de choque foram mcplib84 para fótons e 

e103 para elétrons. Nenhuma alteração foi feita no padrão de transporte de 

partículas MCNP e algoritmos de redução de variância não foram utilizados. A 

execução das simulações terminou quando o número de 107 histórias de partículas 

foi realizada para cada simulação mantendo um erro relativo na faixa de 1%. 
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Figura 17. Posicionamento dos fantomas RFPID e RCP_AF no CCI. 

 

 
Na imagem, os cortes sagital (A) e transversal (B) do RFPID posicionado no CCI e cortes sagital (C) e 

transversal (D) do fantoma RCP_AF posicionado no CCI. 

Fonte: A Autora 

  

A) 

B) 

C) 

D) 
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4 RESULTADOS E DISCUSSÃO 

Neste capítulo, os resultados obtidos (1) do desenvolvimento do fantoma em 

impressão 3D, (2) dos estudos de atenuação do material tecido equivalente e (3) das 

simulações computacionais de teste de susceptibilidade de uso do modelo serão 

apresentados e discutidos.  

Primeiramente, os resultados do processo de desenvolvimento do fantoma 

são detalhados, abordando aspectos como a precisão dimensional, densidade e 

atenuação do material, a qualidade da impressão, a fidelidade do modelo em relação 

ao projeto inicial e as características físicas do fantoma produzido. Em seguida, são 

apresentados os resultados dos estudos de atenuação do material de 

preenchimento proposto, demonstrando os coeficientes de atenuação obtidos em 

comparação com os tecidos biológicos de referência. Isso inclui gráficos, tabelas e 

análises comparativas para validar a tecido equivalência do material proposto. Em 

conclusão a esta seção, os resultados das simulações computacionais são exibidos, 

mostrando a resposta do fantoma em diferentes cenários de exposição à radiação 

simulada. São apresentadas análises dos dados gerados, incluindo a precisão, a 

confiabilidade e a capacidade do fantoma em simular adequadamente as condições 

desejadas. 

 

5.1   DESENVOLVIMENTO DO FANTOMA  

A metodologia desenvolvida neste estudo permitiu a geração de imagens 3D 

de 16 peças que, juntas, compõem o fantoma feminino de referência da ICRP. Todo 

o processo de manipulação de imagens envolveu apenas software freeware. Estas 

peças, separadas em volumes ocos com respectivas tampas, foram impressas com 

sucesso em impressoras 3D de baixo custo. Cada peça teve uma duração de 

impressão única e exigiu uma quantidade específica de material, acumulando um 

tempo total de impressão de cerca de dois meses para finalizar todo o fantoma. A 

impressão completa do RFPID, juntamente com as suas peças e suportes, utilizou 



77 

cerca de 15 kg de filamento, o que equivale a uma despesa financeira de cerca de 

USD 300,00.  

Os componentes impressos em 3D e os encaixes adicionados atenderam 

com sucesso ao seu propósito. A Figura 18 mostra um exemplo de peça de uma 

parte da cabeça, com seu interior oco e sua tampa. 

 

Figura 18. Exemplo de uma peça do RFPID 

 

A) Mostra a peça de parte da cabeça com estrutura interna oca para preenchimento e o canal de 

encaixe para a tampa; B) apresenta a tampa com o furo para inserção do material de preenchimento 

e o encaixe tipo macho e; C) A peça e sua tampa encaixadas, formando a peça completa. 

Fonte: A Autora 

 

O modelo impresso está alinhado com as diretrizes da ICRP em tamanho e 

formato da mulher de referência, medindo 163 cm. Espera-se também que o modelo 

atinja o peso aproximado de 60 kg após ser preenchido com o material tecido-

A) 

B) 

C) 
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equivalente contendo o material radioativo, vazio, seu peso total é de 10,72kg. Esta 

fidelidade aos padrões de referência aumenta a precisão da calibração para 

cenários de contaminação real envolvendo indivíduos do sexo feminino, quando 

comparado ao de referência (ver seção 5.4). A aplicação da tecnologia de impressão 

3D associada à metodologia desenvolvida neste trabalho proporciona flexibilidade 

para desenvolver modelos personalizados, adaptados às necessidades específicas 

dos serviços de monitorização in vivo, baseados na manipulação de imagens.  

A Figura 19 ilustra o resultado da impressão do RFPID, destacando 

características anatômicas claramente definidas que estão muito mais próximas da 

realidade do que os fantomas físicos comerciais de corpo inteiro atualmente 

disponíveis, como o BOMAB, EMMA etc. 

 

Figura 19. Fantoma de corpo inteiro RFPID 

    

A) Mostra o fantoma montado completo em posição ortostática e; B) posicionado na cama do 

Contador de Corpo Inteiro 

Fonte: A Autora 

A) B) 
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O RFPID foi estrategicamente projetado para atender às necessidades de 

calibração do laboratório LDI/CDTN, especialmente em configurações de postura 

supina. Embora não seja categorizado como um fantoma modular, o RFPID oferece 

a flexibilidade de ser posicionado em configurações que incluem posturas 

ortostáticas e sentadas em cadeiras, em semelhança a outros modelos como o 

BOMAB (ANSI, 1999), UP-02T (Kovtun et al., 2000) e EMMA (Lebacq et al., 2011). 

Isso confere versatilidade ao posicionamento do fantoma, permitindo sua aplicação 

em diversas situações experimentais. 

O RFPID é projetado para ser um fantoma de longa duração, que é esperada 

devido à longa meia-vida do Eu-152 (13,6 anos) e aos processos aplicáveis de 

conservação do gel balístico. Isso elimina a necessidade de reabastecimento 

frequente com material radioativo. Essa abordagem não apenas reduz os custos 

financeiros, mas também minimiza a produção de resíduos radioativos, 

representando uma significativa melhoria em relação às alternativas disponíveis 

atualmente. Além disso, a durabilidade do RFPID reduz o potencial de contaminação 

externa e interna, o que é uma preocupação recorrente na preparação e enchimento 

de fantomas tradicionais. A escolha do Eu-152 está ligada principalmente ao seu 

tempo de meia-vida e sua emissão gama em uma ampla faixa de energia, vantajoso 

para calibração do CCI. 

Os recursos gastos no projeto giram em torno de US$ 2.500,00 incluindo a 

compra das duas impressoras 3D. Os próximos passos são a selagem das peças 

com resina epóxi e o preenchimento das peças com gel balístico contendo Eu-152. 

Esta é uma etapa complexa e demanda um investimento considerável de tempo 

devido ao manuseio de fonte radioativa não selada e em grande quantidade de 

material. Os recursos previstos para estas etapas são da ordem de US$ 350,00. 

Esse fato demonstra que é possível construir um fantoma físico antropomórfico e 

antropométrico adequado com seu valor de custo de aproximadamente 

US$ 2.850,00 que é aproximadamente 75% inferior aos fantomas comerciais 

comumente usados para fins de calibração de CCI. Esses fantomas custam acima 

de US$ 10.000,00 no mercado atual. 
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4.4.1 Pós processamento 

 A peça impermeabilizada com o RevestikTM Emborrachamento Spray Preto e 

vedada com Adesivo de Poliuretano Preto apresentou vazamento da água, 

penetrando a camada preenchida que pode ser observada na Figura 20. Por outro 

lado, na peça impermeabilizada com resina epóxi e vedada com cola de silicone 

acética, não houve qualquer tipo de vazamento do líquido, um exemplo da mesma é 

visto na Figura 21.  

 

Figura 20. Teste de vazamento da peça impermeabilizada com emborrachamento spray e vedada 

com cola de poliuretano 

 

Em A) é possível ver o vazamento da água inserida na peça e em B) é possível ver que a fonte do 

vazamento provém da parede da peça, não na área de encaixe vedada com a cola de poliuretano. Na 

imagem C) é possível observar a penetração da água em toda parte interna da área impressa e em 

D) um corte da área de vazamento. 

Fonte: A Autora 

A) B) 

C) D) 
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Figura 21. Teste de vazamento da peça impermeabilizada com resina epóxi e vedada com cola 

silicone acético 

  

Em A) a vista frontal e em B) a vista oblíqua da peça sem qualquer fonte de vazamento ou 

impermeabilização na casca impressa ou na área de encaixe entre peça e tampa. 

Fonte: A Autora 

 

Mediante a definição da combinação resina epóxi para impermeabilizante e 

cola de silicone acética como os materiais ótimos para uso nas peças, o 

acompanhamento da perda de massa em função do tempo foi realizado com a 

mesma e com o mesmo modelo sem preenchimento interno (Figura 22), e plotados 

no gráfico presente na Figura 23.  

 

 

 

 

 

A) B) 
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Figura 22. Peças de acompanhamento de perda de massa em função do tempo 

 

À esquerda, a peça vazia e, à direita, a peça preenchida com água 

Fonte: A Autora 

 

Figura 23. Gráfico da perda de massa da peça final em função do tempo 

 

Fonte: Elaborado pela Autora 
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Os dados demonstram uma diferença percentual menor que 1% entre a 

massa final e inicial da peça preenchida com água em um período de três meses de 

acompanhamento, o que sugere que não houve nenhum vazamento ou evaporação 

da água do meio interno para o externo. A peça vazia, no entanto, exibiu variações 

na massa, apresentando-se maior em alguns pontos. Uma hipótese a esse fato pode 

ser às características de absorção da umidade do ar pelo PLA (Limpadapun & 

Sukmanee, 2021), causando variações no seu peso para mais ou para menos.  

Por se tratar de um material biodegradável de origem vegetal, ele pode sofrer 

degradação quando exposto a condições ambientais como umidade e calor. A 

exposição à umidade pode causar hidrólise no PLA, levando à quebra das ligações 

químicas na estrutura molecular e resultando na perda de massa. Além disso, altas 

temperaturas podem acelerar esse processo de degradação (Taib et al., 2023). A 

perda de massa em ambas as peças pode estar associada ao PLA, ainda que a 

perda seja mínima.  

  

5.2     FILAMENTO DE IMPRESSÃO 

Os resultados do estudo de densidade obtidos para os objetos de teste estão 

apresentados na Tabela 8. Os dados demonstram que, à medida que o volume 

aumenta, a densidade do material diminui. Isto era esperado uma vez que volumes 

menores apresentam maior proporção de paredes sólidas em comparação com o 

enchimento interior. As paredes impressas são 100% preenchidas, em contraste 

com o preenchimento de 25% das seções internas. Assim, a densidade de 

pequenos objetos se aproximará muito do valor teórico da densidade do PLA, que é 

em torno de 1,24 g.cm-3 (Barrasa et al., 2021; Niaounakis et al., 2011).  
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Tabela 8. Densidade do PLA com 25% de preenchimento 

Volume (cm3) Densidade (g.cm-3) ±DP 

0,043 1.1783 ± 0.0002 

0,125 0.9648 ± 0.0001 

0,343 0.8538 ± 0.0001 

0,392 0.8193 ± 0.0001 

0,588 0.7624 ± 0.0001 

0,735 0.7566 ± 0.0001 

1,575 0.6743 ± 0.0001 

1,4 0.6937 ± 0.0001 

2,8 0.6084 ± 0.0001 

6,3 0.5810 ± 0.0002 

Fonte: Elaborado pela Autora 

 

Para o RFPID, o volume de cada voxel foi de 0,027 cm3 e um número de 

659.427 voxels de PLA no fantoma, resultando em um volume final de 17.804,53 

cm3. O peso final de todo o simulador foi de 10,72 kg. Desta forma, a densidade final 

do RFPID, sem qualquer material preenchendo-o, é de 0,60 g.cm-3. 

Pode-se observar no gráfico (Figura 24), baseado nos dados da Tabela 8, 

que há uma tendência de estabilização da densidade em torno de 0,6 g.cm-3 para 

volumes maiores. Embora o valor médio de densidade encontrado para o PLA (0,6 

g.cm-3) no simulador tenha sido inferior ao esperado para um tecido equivalente 

(cerca de 1,04 g.cm-3), isso não poderia representar uma grande preocupação. O 

invólucro do PLA não conterá materiais radioativos e uma alta densidade poderá 

resultar em espalhamento e absorção de fótons, o que poderá levar a uma 

diminuição na eficiência de contagem esperada para o sistema (RFPID/CCI).  
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Figura 24. Gráfico da densidade do PLA com 25% de preenchimento 

 

Fonte: Elaborado pela Autora 

 

 Os resultados do coeficiente de atenuação linear e mássico obtidos para o 

PLA com 25% de preenchimento são demonstrados na Tabela 9 e visualmente no 

gráfico presente na Figura 25. As diferenças entre os coeficientes de atenuação 

linear dos dois materiais variam de 61% (2.204,1 keV) a 67% (241,9 keV). As 

maiores variações de detecção ocorreram nas áreas dos picos de 241,9 keV, sendo 

relacionada principalmente aos efeitos das camadas compton de energias mais altas 

presentes nessa região do espectro, o que pode ter contribuído para maiores 

diferenças nesse pico de energia.   

 

 

 

 

 

 

 



86 

Tabela 9. Coeficientes de atenuação linear do PLA 25% de preenchimento em comparação ao 

músculo 

Energia (keV) Músculo (cm-1) PLA 25% (cm-1) Δ (%) 

186,1 0,139 0,051 -65% 

241,9 0,127 0,044 -67% 

295,2 0,118 0,046 -63% 

351,9 0,110 0,041 -65% 

609,3 0,088 0,035 -62% 

1120,3 0,066 0,025 -64% 

1759 0,052 0,020 -64% 

2204,1 0,046 0,019 -61% 

Fonte: Elaborado pela Autora 

 

Figura 25. Gráfico dos coeficientes de atenuação linear do PLA com 25% de preenchimento 

 

Fonte: Elaborado pela Autora 

 

As simulações computacionais envolvendo o RFPID com o PLA em 

densidade 0,6 g.cm-3 quando comparado ao RCP_AF na calibração em eficiência de 

contagem do sistema CCI, descritas no subtópico 5.4 deste trabalho, revelarão se 
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haverá discrepâncias consideráveis entre os dois. Mesmo que uma discrepância 

relativamente grande seja detectada neste estudo, é possível modular a densidade 

do PLA de 1,2 para < 0,6 g.cm-3 (neste caso, com preenchimentos inferiores a 25%). 

Além disso, fatores de correção computacional podem ser gerados para as medidas. 

 

5.3   GEL BALÍSTICO 

O objetivo deste estudo é criar fantomas de calibração homogêneos para CCI, 

portanto o foco principal está na avaliação do coeficiente de atenuação linear do gel 

balístico. Cálculos de densidade foram realizados em cada amostra individual de gel 

O objetivo deste estudo é criar fantomas de calibração homogêneos para CCI, 

portanto o foco principal está na avaliação do coeficiente de atenuação linear do gel 

balístico. Cálculos de densidade foram realizados em cada amostra individual de gel 

balístico do Grupo 1 (G1) e Grupo 2 (G2), a média do primeiro foi de 1,11 ± 0,02 

g.cm-3 e para o segundo, obteve-se uma densidade média de 1,11 ± 0,03 g.cm-3. 

Esses resultados são estatisticamente iguais e demonstram uma reprodutibilidade 

da amostra. O valor encontrado desvia-se em aproximadamente 6% da densidade 

do tecido muscular preconizada pelo ICRU, que é de 1,05 g.cm-3 (ICRU, 1989).  

A Tabela 10 apresenta o resultado do cálculo das diferenças entre os tecidos 

substitutos e os musculares. A diferença percentual entre os coeficientes dos 

materiais e do músculo foi calculada utilizando a Equação 6. Quantitativamente, o 

Grupo 1 apresentou diferenças não superiores a 8% nos coeficientes de atenuação 

linear quando comparado ao tecido muscular, enquanto o Grupo 2 revelou 

diferenças ≤7%. Em contrapartida, foram observados desvios de -4% e 11% para 

água e para o PMMA em relação ao músculo, respectivamente.  

Quando comparados os G1 e G2 entre si, as diferenças variam de 3% a 12%, 

sendo a atenuação das amostras do G2 mais baixas. Isso se deve ao fato de que as 

amostras do G2, pós irradiação, terem formado bolhas de ar na sua estrutura, os 

detalhes das diferenças físicas entre as amostras irradiadas e não irradiadas são 

discutidos mais abaixo.  O G2 apresentou coeficientes semelhantes aos da água, 
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sendo mais próximas aos do músculo para algumas energias, como 186,1, 241,9, 

295,2 e 1759 keV. O coeficiente de atenuação linear é ilustrado graficamente na 

Figura 26. 

 

Figura 26. Gráfico dos coeficientes de atenuação linear do gel balístico comparados ao músculo, 

água, PMMA e aos coeficientes obtidos pelo NIST XCOM. 

 

Fonte: Elaborado pela Autora 
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Tabela 10. Coeficientes de atenuação linear do músculo da ICRU comparados aos do gel balístico (Grupo 1 e Grupo 2, experimentalmente calculado 

neste trabalho), à água e ao PMMA. 

 

Energia 

(keV) 

Músculo 

(ρ = 1.05 g.cm-3) 

Gel Balístico G1 

(ρ = 1.11 g.cm-3) 

Gel Balístico G2 

(ρ = 1.11 g.cm-3) 

Água 

(ρ = 1.0 g.cm-3) 

PMMA 

(ρ = 1.19 g.cm-3) 

μ (cm-1) μ (cm-1) Δ (%) μ (cm-1) Δ (%) μ (cm-1) Δ (%) μ (cm-1) Δ (%)   

186,1 0,146 0,156±0,002 -7% 0,144±0,001 -1% 0,140 -4% 0,162     11%    

241,9 0,133 0,135±0,002 1% 0,131±0,001 -2% 0,128 -4% 0,148 11%  

295,2 0,124 0,132±0,001 6% 0,120±0,001 -3% 0,119 -4% 0,138 11%  

351,2 0,116 0,121±0,001 4% 0,111±0,001 -5% 0,112 -4% 0,129 11%  

609,3 0,099 0,099±0,001 7% 0,087±0,001 -5% 0,089 -4% 0,103 11%  

1120,3 0,070 0,072±0,001 3% 0,065±0,000 -6% 0,067 -4% 0,077 11%  

1759 0,055 0,060±0,001 8% 0,054±0,000 -2% 0,053 -4% 0,061 11%  

2204,1 0,049 0,052±0,001 6% 0,045±0,000 -7% 0,047 -4% 0,054 11%  

Fonte: Elaborado pela Autora 
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Em comparação com o tecido muscular e outros materiais em um aspecto 

geral, a água apresenta características superiores de atenuação da radiação, 

acompanhada do gel balístico do grupo irradiado (G2). No caso do PMMA, o 

coeficiente de atenuação linear apresenta uma diferença mais nítida, com aumento 

de 11% em relação ao tecido muscular. Essa diferença é atribuída principalmente à 

alta densidade do PMMA, que afeta diretamente os valores do seu coeficiente de 

atenuação linear.  

Quando comparados aos coeficientes obtidos pelo NIST, como registrado na 

Tabela 11, as simulações computacionais com o código TOPAS apresentaram 

resultados muito próximos, com uma diferença abaixo de 1% para todas as 

energias. Os resultados experimentais mostram que o que o gel balístico do grupo 

não irradiado (G1) teve seus valores semelhantes aos obtidos por meio do NIST 

XCOM, com diferenças não maiores que 4%. A afirmação também é verdadeira 

quando comparados os resultados computacionais com o experimental G1. Sendo 

assim, seus valores são muito mais próximos dos resultados teóricos do que o G2 

que, por sua vez, se aproxima mais aos coeficientes de atenuação da água. Para o 

G2, as diferenças com o NIST chegam a até -12%. Esse fato não desqualifica o uso 

da irradiação no material, ainda que tenha diminuído suas propriedades de 

atenuação, elas ainda ficaram bem mais próximas ao do músculo, com diferenças 

ainda menores que o G1 para algumas energias, como observado na Tabela 10. As 

possíveis causas da diminuição das propriedades de atenuação são citadas mais 

abaixo, na observação do comportamento físico das amostras dos dois grupos.  
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Tabela 11. Comparação dos coeficientes de atenuação linear experimentais e computacionais com o 

NIST XCOM 

 NIST TOPAS 
Δ TOPAS 

e NIST  
Δ (G1 e 
NIST) 

Δ G2 e 
NIST 

Δ TOPAS 
e G1 

Δ TOPAS 
e G2 

Energia 
(keV) 

μ (cm-1) μ (cm-1) (%) (%) (%) (%) (%) 

186,1 0,154 0,154 -0,07% 1% -6% -1% 7% 

241,9 0,141 0,140 -0,56% -4% -7% 4% 7% 

2952 0,131 0,130 -0,77% 1% -8% -1% 8% 

351,9 0,123 0,122 -0,46% -1% -10% 1% 10% 

609,3 0,098 0,098 -0,17% 1% -10% -2% 11% 

1120,3 0,073 0,073 -0,12% -2% -11% 2% 12% 

1759 0,058 0,058 -0,75% 3% -8% -3% 7% 

2204,1 0,051 0,051 -0,46% 0% -12% -1% 13% 

Fonte: Elaborado pela Autora 

 

Num contexto mais amplo, neste experimento constatou-se que a água serve 

como tecido substituto ideal seguida do gel balístico G2 e G1, enquanto o PMMA 

apresentou uma taxa de atenuação mais elevada em comparação com os outros 

dois materiais estudados, superando a do tecido muscular humano. Além disso, as 

características atenuantes do gel balístico demonstram uma aproximação às do 

músculo. Além disso, a densidade do gel balístico apresentou diferença inferior a 6% 

em relação à densidade do tecido muscular do ICRU. A diferença para a água é 

inferior a 5%, enquanto para o PMMA é de cerca de 13%. 

Em relação às observações referentes ao comportamento físico do gel 

balístico do Grupo 1, não irradiado e sob diversas temperaturas, alguns fatores 

significativos podem ser pontuados:  

a) O material possui consistência de gel sólido firme e sensação tátil não úmida 

após a gelificação.  

b) O gel balístico é mais firme quando refrigerado, mas apresenta alterações 

mínimas em temperaturas ambientes controladas. Porém, quando exposto a 
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altas temperaturas (> 30° C), inicia um processo de liquefação, que gelifica 

novamente se colocado em temperaturas mais baixas (≤ 23º C).  

c) Após menos de duas semanas do preparo, as amostras armazenadas em 

temperatura ambiente apresentaram proliferação microbiana, caracterizada 

pelo crescimento de fungos. Para as amostras armazenadas sob refrigeração, 

a proliferação torna-se perceptível cerca de três a quatro semanas após 

(Figura 27). 

d) As amostras pesadas em ambas as temperaturas indicam uma redução de 

5% na massa do material após três semanas. Indicando uma possível 

desidratação devido evaporação da água.  
 

Figura 27. Proliferação microbiana nas amostras do Grupo 1 

 

Em A) e B) Amostras sob refrigeração; C) sob temperatura controlada; e D) sob temperatura ambiente 

Fonte: A Autora 

A) B) 

C) D) 

REFRIGERAÇÃO REFRIGERAÇÃO 

TEMPERATURA AMBIENTE CONTROLADA TEMPERATURA AMBIENTE 
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As amostras do Grupo 2, irradiadas (25 kGy e 50 kGy) e armazenadas em 

ambiente com temperatura controlada (23 ºC), tem os seguintes fatores significativos 

a serem pontuados: 

a) Todas as amostras exibiram a formação de bolhas de ar, com gases ainda 

não identificados (Figura 28). Porém, nas amostras irradiadas com 50 kGy 

essas bolhas foram mais pronunciadas.  

 

b) A coloração das amostras assumiu um tom mais claro, em ambas as doses. 

c) Mesmo passadas quatro semanas em uma temperatura de 23° C, nenhuma 

das amostras apresentou proliferação microbiana.  

d) A consistência do material ainda foi firme e não úmida ao tato mesmo não 

refrigerada. Uma amostra submetida a temperaturas não controladas (até 

38º C), também iniciou processo de liquefação, como a do Grupo 1.  

 

Com base nos resultados dos testes, o gel balístico demonstra ter potencial para 

funcionar como tecido substituto no desenvolvimento de simuladores físicos de 

calibração para sistemas de monitoração in vivo. Os resultados estão de acordo com 

os requisitos necessários para coeficientes de atenuação linear, conforme 

estabelecido no Report-44 da Comissão Internacional de Unidades e Medidas da 

Radiação (ICRU, 1989). Este relatório especifica que o material em consideração 

deve ser tecido-equivalente dentro da faixa de energia pretendida para uso. Porém, 

em alguns casos envolvendo simuladores de calibração para CCI, o ICRU-44 (ICRU, 

1989) permite variações consideráveis entre o tecido substituto e o tecido humano. 

O texto, porém, não prescreve quaisquer limites para essas variações. 
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Figura 28. Amostras do Grupo 2 no decorrer do tempo após irradiação 

 

 

 

 

A) Amostras um dia após irradiação, onde é possível ver as bolhas presentes nas amostras irradiadas 

com 50 kGy e o início de liquefação em uma delas; B) amostras 7 dias após irradiação; C) amostras 

após 21 dias de irradiação; e D) amostras 30 dias após a irradiação. 

Fonte: A Autora 

 

A esterilização por irradiação gama provou-se eficaz para solução da 

proliferação microbiana, sendo a dose de 25 kGy suficiente para tal. Acerca do 

problema de perda de massa devido a evaporação da água, ele pode ser evitado se 

A) 

25 kGy 25 kGy 50 kGy 50 kGy 

B) 

25 kGy 25 kGy 50 kGy 50 kGy 

C) 

25 kGy 25 kGy 50 kGy 50 kGy 

D) 

25 kGy 25 kGy 50 kGy 50 kGy 
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o material for armazenado em um compartimento completamente selado, sendo 

esse um objetivo atingido nas peças impressas do RFPID utilizando resina epóxi e 

cola de silicone acética. O gel balístico pode ser mantido em temperaturas amenas e 

por um longo tempo, sem necessidade de se manter sob refrigeração quando este 

estiver esterilizado. Em trabalhos futuros, pretende-se analisar a dose mínima 

necessária para esterilização do gel balístico.  

 

5.4   MODELAGEM E SIMULAÇÃO COMPUTACIONAL DO RFPID 

O tempo total para executar todas as 28 simulações com os fantomas RFPID 

e RCP_AF foi de aproximadamente 189 horas. Os erros relativos (ER) dos 

resultados da simulação foram inferiores a 1% para todas as energias, exceto 25 

keV, que foi inferior a 1,5%. A eficiência calculada a partir das simulações é 

apresentada na Tabela 12. A diferença percentual entre os resultados de eficiência 

dos fantomas RFPID e RCP_AF foi calculada seguindo a Equação 7: 

A eficiência variou de 6,76E-04 a 2,31E-03 pulsos.fóton-1 para o simulador 

RFPID e de 9,88E-04 a 2,32E-04 pulsos.fóton-1 para o simulador RCP_AF. Dentre 

as energias estudadas, o pico de maior eficiência ocorreu na energia de 250 keV 

para ambos os modelos. A reduzida eficiência de detecção de um NaI(Tl) para 

baixas energias pode ser atribuída à alta absorção de fótons no corpo e na janela do 

detector. A maior diferença (31,62%) na eficiência de ambos os modelos foi 

observada para fótons de 25 keV e indica que as diferenças entre os dois fantomas 

em termos de geometria e composição do material não podem ser negligenciadas 

nesta faixa de energia, uma vez que o RCP_AF é heterogêneo e possui diferentes 

densidades, como o osso que atenua consideravelmente nessas energias. Porém, 

discrepâncias para a energia deste fóton não são uma grande fonte de preocupação, 

uma vez que os detectores NaI(Tl) apresentam uma variação excessiva na eficiência 

de detecção na região de baixa energia (Zerby et al., 1961), também demonstrada 

neste trabalho. 
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Tabela 12. Resultados da eficiência (ε) do RFPID e RCP_AF para diferentes fótons monoenergéticos 

Energia 

(keV) 

 (pulsos.fóton-1) 

Δ (%) RFPID RCP_AF 

Média ER DP Média ER DP 

25 6,76E-04 1,22% 8,24E-06 9,88E-04 1,01% 9,98E-06 -31,62% 

50 2,88E-03 0,59% 1,70E-05 3,17E-03 0,56% 1,78E-05 -9,05% 

75 3,66E-03 0,52% 1,90E-05 4,00E-03 0,50% 2,00E-05 -8,53% 

100 3,51E-03 0,53% 1,86E-05 3,84E-03 0,51% 1,96E-05 -8,64% 

250 4,11E-03 0,49% 2,01E-05 4,35E-03 0,48% 2,09E-05 -5,67% 

500 3,95E-03 0,53% 2,10E-05 4,12E-03 0,49% 2,02E-05 -4,02% 

750 3,64E-03 0,52% 1,89E-05 3,75E-03 0,52% 1,95E-05 -2,96% 

1000 3,39E-03 0,54% 1,83E-05 3,45E-03 0,54% 1,86E-05 -1,89% 

1250 3,16E-03 0,56% 1,77E-05 3,24E-03 0,55% 1,78E-05 -2,38% 

1500 2,98E-03 0,58% 1,73E-05 3,05E-03 0,57% 1,74E-05 -2,47% 

1750 2,83E-03 0,59% 1,67E-05 2,87E-03 0,59% 1,69E-05 -1,45% 

2000 2,69E-03 0,61% 1,64E-05 2,73E-03 0,60% 1,64E-05 -1,68% 

2500 2,47E-03 0,64% 1,58E-05 2,50E-03 0,63% 1,57E-05 -1,13% 

3000 2,31E-03 0,66% 1,52E-05 2,32E-03 0,69% 1,60E-05 -0,41% 

Fonte: Elaborado pela Autora 

 

Na faixa de energia de 50 keV a 1000 keV, as diferenças em relação ao 

modelo heterogêneo variaram de 9,05% a 1,89%. Esta região de energia é 

importante para a detecção de contaminações internas utilizando NaI(Tl). Isso ocorre 

devido à maior eficiência, ao baixo ruído e ao fato de vários radionuclídeos de 

interesse emitirem raios gama nesta faixa de energia. A utilização de fatores de 

correção é indicada caso sejam necessários resultados com maior grau de precisão. 

Estes fatores podem compensar desvios que possam surgir durante a calibração do 

sistema CCI para esse intervalo de energia.  

Para energias ≥ 1000 keV, as diferenças na eficiência, abaixo de 2,5%, não 

são estatisticamente significativas em aplicações de dosimetria interna. Esse fato 
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implica que os resultados da calibração usando o RFPID homogêneo com o gel 

balístico e o RCP_AF heterogêneo com seus diferentes tecidos e órgãos são 

comparáveis na faixa de alta energia. A Figura 29 apresenta o gráfico com as 

curvas de eficiência em função da energia para ambos os fantomas.  

 

Figura 29. Curvas de eficiência para o RFPID e RCP_AF em função da energia. 

 

Fonte: A Autora 

 

O aspecto da curva de eficiência, apresentado em função da energia (Figura 

29), está alinhado com resultados de pesquisas anteriores. Pacheco (2023) simulou 

a eficiência de contagem do detector cintilador NaI(Tl) e observou padrão de curva 

semelhante em relação ao sistema CCI utilizado neste estudo. Da mesma forma, 

Lebacq et al (2011) relataram características de curva semelhantes em sua pesquisa 

de simulação usando os fantomas de corpo inteiro, EMMA, cobrindo diferentes 

tamanhos, desde pediátricos até adultos. Este comportamento de curva permaneceu 

consistente em todos os tamanhos de fantoma. 

Em estudos experimentais anteriores no mesmo laboratório utilizando 

fantomas PET-BOMAB e BOMAB, Paiva et al (2017) encontrou a mesma 
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configuração de curva com pico de mais alta eficiência na energia de 300 keV. O 

mesmo aconteceu nos estudos computacionais e experimentais do grupo em 2016.    

Park et al. (2023) observaram um padrão de curva de eficiência em função da 

energia semelhante usando um detector NaI(Tl) em seu experimento. Seus 

resultados sustentam resultados consistentes tanto em simulações quanto em 

experimentos, usando o fantoma BOMAB adulto masculino. Ferreira et al. (2023) 

também encontraram resultados semelhantes em simulações de vários fantomas 

com um detector NaI(Tl).  

Estudos de Fonseca et al (2014) utilizando um detector HPGe e uma 

biblioteca de fantomas masculinos e femininos, variando peso e altura, encontrou 

para todos eles, o mesmo padrão de curva de eficiência em função da energia. 

Demais estudos com HPGe e outros fantomas também exibem um padrão de curva 

comparável, embora o pico de maior eficiência ocorra em energias mais baixas 

quando comparadas ao NaI(Tl), em torno de 250 keV (Bento et al., 2012; Schläger, 

2011; Takahashi et al., 2011; B. Zhang et al., 2008).  

Um gráfico com dados de pesquisa de Paiva et al (2016) experimentais o com 

PET-BOMAB e computacionais com o fantoma masculino de voxel de referência da 

ICRP-110 (2009), o RCP_AM, foi plotado conjuntamente com os dados do RFPID e 

RCP_AF e pode ser visto na Figura 30. 

Nas curvas apresentadas, o fantoma RCP_AM possui uma maior eficiência de 

contagem em ambos os códigos simulados (MCNPX e VMC), com picos de 

eficiência em torno de 300 keV. Os resultados experimentais com o PET-BOMAB 

apresentaram pontos de curva com menor eficiência quando comparados ao 

RCP_AM, porém seus pontos na curva se assemelham com o RCP_AF e muito 

próximos também da curva referente ao RFPID. Os pontos da curva do PET-BOMAB 

se referem às energias do 133Ba, 60Co e 137Cs. 
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Figura 30. Comparação das curvas de eficiência em função da energia do RFPID e RCP_AF com os 

do trabalho de Paiva et al (2016) 

 

Fonte: Dados da Autora e dados de Paiva et al (2016) 

 

Estes achados consistentes destacam a estabilidade da curva de eficiência 

em função da energia encontrada através de diversas metodologias e estudos, 

ressaltando a relevância do simulador desenvolvido e a aplicabilidade na calibração 

de detectores em eficiência de contagem da radiação. 

Embora o fantoma de calibração RFPID demonstre resultados encorajadores 

nas simulações computacionais, estudos experimentais são necessários para 

confirmar sua eficácia. O simulador físico impresso em 3D, RFPID, deve ser usado 

para verificar experimentalmente o desempenho do fantoma em cenários reais. A 

validação experimental produzirá evidências mais confiáveis da precisão do 

fantoma, reforçando sua adequação para aplicações práticas em calibrações de 

sistemas CCI. 
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5 CONCLUSÃO 

Neste trabalho foi proposta a impressão 3D do fantoma feminino da ICRP de 

corpo inteiro com filamento de PLA. O simulador impresso resultante foi satisfatório 

quanto aos detalhes anatômicos, tamanho, forma, composição do material, 

resistência mecânica e custos financeiros. O estudo avaliou também a adequação 

do uso de gel balístico como tecido substituto no desenvolvimento de simuladores 

físicos para calibração de sistemas contador de corpo inteiro. O coeficiente de 

atenuação linear foi obtido e os resultados indicaram uma forte correlação entre o 

gel balístico e o músculo, com discrepância inferior a 6% na densidade. O 

coeficiente de atenuação linear variou menos de 9% em energias na faixa de 186,1 

a 2.204,1 keV para ambos os grupos de amostras testados.  

Quanto às propriedades físicas do gel balístico submetido a diversas 

temperaturas, este manteve consistência sólida, não apresentou umidade ao tato e 

não apresentou sinais de liquefação durante o período de estudo quando em 

temperatura controlada e abaixo de 25º C. As preocupações com o crescimento 

microbiano e a evaporação da água podem ser adequadamente solucionadas a 

partir da esterilização por radiação gama após o enchimento do gel balístico em um 

recipiente hermeticamente fechado. A formação de bolhas de ar pós esterilização 

reduziram a atenuação do material, mas ainda a manteve muito próxima ao do 

músculo. Mais testes se fazem necessários para o entendimento de quais gases 

estão sendo gerados nesse material e qual o limiar de dose em que elas se formam.  

O fantoma RFPID foi modelado e simulado usando o código de Monte Carlo 

MCNP6.2, com sua casca em PLA com a densidade de 25% de preenchimento e as 

peças preenchidas com o gel balístico estudado. As curvas de eficiência em função 

da energia foram obtidas para o fantoma homogêneo RFPID e para o fantoma 

heterogêneo de referência RCP_AF. Embora tenha havido uma diferença 

significativa entre os fantomas na menor energia simulada (-31,62%), houve apenas 

uma variação limitada (<9,1%) observada para energias acima de 50 keV. Fatores 

de correção são indicados para energias com diferenças acima de 2,5%, quando o 

fantoma for validado experimentalmente no futuro. 
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As descobertas do estudo indicam que os RFPID impresso em PLA e 

preenchido com gel balístico pode servir como fantoma de calibração para sistemas 

contadores de corpo inteiro. Porém, a validação experimental com o modelo físico é 

necessária para confirmar os resultados deste estudo quando o simulador for 

preenchido com gel balístico contendo fonte de Eu-152. Assim, o objetivo de 

trabalhos futuros é adicionar Eu-152 ao gel balístico de forma a preencher os 16 

compartimentos do modelo físico. Este será utilizado para calibração do CCI do 

LDI/CDTN/CNEN em Minas Gerais, Brasil. 

A metodologia proposta neste trabalho permite o desenvolvimento de 

simuladores físicos com melhor custo-benefício e detalhamento anatômico 

aprimorado quando comparados aos simuladores disponíveis comercialmente para 

os mesmos fins, sendo até 75% menos oneroso. Espera-se que o acesso dos 

serviços de monitorização in vivo a modelos físicos de baixo custo seja facilitado, 

bem como uma redução nas incertezas associadas aos coeficientes de calibração 

na monitoração in vivo. 

 

5.1   PUBLICAÇÕES  

Durante este estudo, trabalhos foram apresentados e submetidos para 

publicação. Em novembro de 2022, como uma iniciação ao aprendizado aos códigos 

de Monte Carlo, foi desenvolvido e apresentado um trabalho na Semana Nacional de 

Engenharia Nuclear e da Energia Ciências das Radiações (VI SENCIR), intitulado 

como “Lei do Inverso do Quadrado da Distância: Intercomparação Entre Dois 

Códigos de Monte Carlo” (Andrade et al., 2022). Em abril de 2023, foi apresentado e 

publicado nos anais do International Symposium on Trends in Radiopharmaceuticals 

(ISTR 2023) da Agência Internacional de Energia Atômica em Vienna, em forma de 

resumo, o trabalho intitulado “Development of 3d-Printed Mice Phantom for Micropet 

System Calibration” (Andrade, Ferreira, et al., 2023). Esse trabalho foi o início das 

aplicações de impressão 3D no desenvolvimento de fantomas, consistindo em um 
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fantoma de camundongo para calibração de sistemas PET (do inglês, Positron 

Emmission Tomography) para pequenos animais (Andrade, Ferreira, et al., 2023). 

Em setembro de 2023, dois trabalhos completos foram apresentados e 

publicados nos anais do XXIII International Symposium on Solid State Dosimetry 

(ISSSD-2023), ocorrido na Colômbia, intitulados como “Monte Carlo Modeling and 

Simulation of a New 3D Printed Phantom for Whole-Body Counter Calibration” 

(Andrade, Paixão, Mendes, et al., 2023) e “Study of ballistic gel as a tissue substitute 

for using on internal dosimetry physical phantoms development” (Andrade, Paixão, 

Neto, et al., 2023). 

Os trabalhos apresentados no ISSSD-2023 foram reunidos em um artigo e 

esse foi submetido para edição especial do simpósio em periódico internacional. 

Outro artigo sobre o desenvolvimento do fantoma foi submetido para periódico 

internacional e já está em processo de revisão.  
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6 PERSPECTIVAS FUTURAS 

As etapas a seguir em trabalhos futuros incluem a impermeabilização de 

todas as peças com resina epóxi, além do acompanhamento da perda de massa em 

função do tempo das peças impressas em câmara climática com temperatura e 

umidade controladas para análise do efeito desses fatores no armazenamento das 

peças do fantoma. 

Quanto ao gel balístico, pretende-se conduzir estudos para definir a dose 

mínima necessária para esterilização do material e analisar qual o limiar de dose 

para formação dos gases e quais destes são formados. Após resultados favoráveis, 

o RFPID será então preenchido com o gel balístico contendo atividade conhecida de 

Európio-152 e o modelo será validado experimentalmente. A partir disso, com auxílio 

de modelos biocinéticos da ICRP e os fantomas computacionais voxelizados da 

ICRP, serão conduzidos estudos computacionais para estabelecimento de 

coeficientes de correção das medidas levando em consideração a biodistribuição 

dos radionuclídeos, como deposição, retenção, transferência sanguínea e excreção 

em função do tempo.  
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APÊNDICE I 

 

Metodologia de manipulação das imagens para criação do simulador físico 

Reference Female Phantom for Internal Dosimetry 

 

O Reference Female Phantom for Internal Dosimetry, ou RFPID, é um 

simulador físico impresso em 3D elaborado para fins de calibração em eficiência de 

um Contador de Corpo Inteiro. O RFPID foi desenvolvido a partir do Reference 

Computational Phantom Adult Female (RCP_AF), um fantoma de voxel feminino de 

referência disponibilizado pela Comissão Internacional de Proteção Radiológica 

(ICRP, do inglês International Comission of Radiation Protection) em sua Publicação 

110, intitulada Adult Reference Computational Phantoms. A ICRP preconiza, como 

uma mulher de referência, uma altura de 1,60 m e com 60 kg de massa. 

Neste documento estarão descritos a metodologia própria e detalhada de 

manipulação das imagens do RCP_AF até que se obtenha as imagens imprimíveis 

do fantoma RFPID. Objetiva-se que o leitor, caso tenha interesse, possa reproduzi-lo 

a partir do passo-a-passo aqui descrito. Este processo está descrito em forma de 20 

tópicos em ordem cronológica de produção de todas as peças do simulador. 

A ICRP-110 disponibiliza seus fantomas em uma série de dados textuais, 

sendo assim necessária a conversão desses dados para imagem. Para realizar tal 

medida, um programa próprio, desenvolvido pelo Prof. Dr. Bruno Mendes em 

linguagem C++, foi utilizado. O mesmo pode ser feito com diversos programas 

desenvolvidos com outras linguagens de programação de preferência. 

A partir da obtenção das imagens do RCP_AF, os procedimentos a seguir 

explanados devem ser adotados. Para cada um dos processos descritos abaixo, 

será designada uma pasta para salvamento da sequência de imagens. Tal meio 

objetiva evitar perda de todos os feitos anteriores caso algo dê errado em um dos 

processos. O nome de cada pasta segue de acordo com preferências pessoais de 

cada pessoa, não sendo necessário seguir os mesmos nomes aqui citados.
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1. Salve a sequência de 350 imagens do fantoma de voxel RCP_AF em uma 

pasta de trabalho.  

 

2. Corte sagital das imagens: Carregue a pasta de trabalho com as imagens 

originais para o ImageJ® → Selecione a forma “Rectangle” → Selecione a 

metade direita da imagem → Clique em Image → Crap → File → Save As → 

Image Sequence → Selecione a pasta “Originais” designada na pasta “Lado 

direito” → Tipo de Imagem: TIFF/ Start at: 1/ Digits: 3 → Save. 

 

3. Repita o passo 2 para o lado esquerdo. 

 

 

Os passos a seguir devem ser feitos para ambos os lados. 

4. Binarização das imagens: carregue a pasta de trabalho no ImageJ® → Clique 

em Image → Adjust → Threshold → Defina “min: 1” e “max: 255” → Selecione 

a opção “Default” e “Red” → marque a caixinha “Don’t reset range” → Apply → 

Na nova janela, desmarque todas as caixinhas e dê “OK” → File → Save As → 

Image Sequence → Selecionar pasta de trabalho “Binários” → Tipo de Imagem: 

TIFF/ Start at: 1/ Digits: 3 → Save. 

 

 

Figura 1. Captura de tela do processo para aplicação da binarização das imagens. 

Fonte: O Autor 

 

5. Mudando a escala de pixels: Carregar a pasta “Binários” no ImageJ® → 

Image → Scale → “X e Y = 1.775” e “Z = 4.84” → Defina: Interpolation = “None” 

→ Desmarque todas as caixinhas → Apply → Com a nova janela com a 

sequência de 1694 imagens criadas, selecione File → Save As → Image 

Sequence → Selecionar pasta de trabalho “1x1x1 mm” → → Tipo de Imagem: 

TIFF/ Start at: 1/ Digits: 4 → Save. 
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Figura 2. Captura de tela do processo de mudança de escala dos pixels. À direita, o montante de 
imagens resultantes (de 350 para 1694). 

Fonte: O Autor 

 

6. Diminuir serrilhamento nas bordas das imagens: Carregar pasta de 

trabalho “1x1x1 mm” no ImageJ → Filters → Gaussian Blur 3D → Defina “X = 

2”, “Y = 2”, “Z = 6” → Apply -> File → Save As → Image Sequence → 

Selecionar pasta de trabalho “Gaussian Blur 2x2x6” → Tipo de Imagem: TIFF/ 

Start at: 1/ Digits: 4 → Save. 

 

 

Figura 3. Captura de tela do processo de aplicação do filtro para diminuição do serrilhamento das 
bordas. À direita, o resultado em uma das imagens. 

Fonte: O Autor 

 

7. Binarização das imagens com filtro aplicado: Carregar pasta “Gaussian Blur 

2x2x6” no ImageJ® → Image → Adjust → Threshold → Defina “min = 127” e 
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“max 255” → Selecione a opção “Default” e “Red” → marque a caixinha “Don’t 

reset range” → Apply → Na nova janela, desmarque todas as caixinhas e dê 

“OK” → File → Save As → Image Sequence → Selecionar pasta de trabalho 

“Gaussian_Bin” → Tipo de Imagem: TIFF/ Start at: 1/ Digits: 4 → Save. 

 

 

Figura 4. Captura de tela dos parâmetros para binarização das imagens. 

Fonte: O Autor 

 

8. Separação das peças: Crie uma pasta de trabalho para separação das futuras 

peças do fantoma. Dentro dela, crie pastas de trabalho separadas para cada 

peça. O número de imagens para cada peça variará de acordo com a altura de 

impressão desejada e possível para impressora a ser utilizada para impressão 

das mesmas. Aqui, foram feitas peças de 20 cm de altura, dessa forma, foram 

separadas 200 imagens para cada peça e 294 para as últimas peças 

correspondente aos pés. Uma vez que os pixels possuem dimensões 1x1x1 

mm3, cada imagem corresponde a um milímetro de altura na peça final. Dentro 

da pasta designada para a peça, salve o conjunto de imagens em uma pasta 

de trabalho nomeada como “Originais”, para separá-las dos processos 

subsequentes.  

 

 
Figura 5. Exemplo da separação de imagens para as peças. 

Fonte: O Autor 
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Os passos a seguir descrevem a criação das peças, aqui também nomeadas 

como “cascas”, e devem ser realizados em cada pasta de trabalho referente às 

peças de impressão. 

 

9. Processo de diminuição das bordas para criação da casca: Carregar pasta 

de trabalho com o conjunto de imagens separada para a peça → Process → 

Erode → Clique em “Yes” para que o processo seja feito em todas as imagens 

→ Repetir 7x → File → Save As → Image Sequence → Selecionar pasta de 

trabalho “Erodidos” → Tipo de Imagem: TIFF/ Start at: 1/ Digits: 3 → Save. 

Obs: o processo de erodir a imagem remove uma camada de pixels das bordas. O 

número de vezes em que o processo de erosão ocorre pode variar caso queira uma 

peça com espessura diferente. Cada erosão equivalerá a um milímetro de casca no 

final. 

 

Figura 6. Captura de tela do processo de erosão das imagens. 

Fonte: O Autor 

 

10. Criação da primeira casca: Carregar as pastas de trabalho “Originais” e 

“Erodidos” no ImageJ® → Process → Image Calculator → Defina: “Image 1 = 

Originais”, “Operation = Subtract”, “Image 2 = Erode” → Marque a caixinha 

“Creat New Window” → Apply → Clique em “Yes” para que o processo seja 

feito em todas as imagens → File → Save As → Image Sequence → 

Selecionar pasta de trabalho “Casca 1” → Tipo de Imagem: TIFF/ Start at: 1/ 

Digits: 3 → Save. 
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Figura 7. Captura de tela do processo de criação da Casca 1. À direita, a casca criada ao final do 
processo. 

(Fonte: O Autor) 

 

11. Fechando as bordas no eixo Z: Carregue a pasta de trabalho “Originais” no 

ImageJ® → Stacks → Reslice [/] → Marque as caixinhas “Rotate 90 degrees” e 

“Avoid interpolation” → Defina: “Output spacing (pixels) = 1.000”, “Start at = 

Top” → Apply → File → Save As → Image Sequence → Selecionar pasta de 

trabalho “Reslice” → Tipo de Imagem: TIFF/ Start at: 1/ Digits: 3 → Save. 

 

 

Figura 8. Captura de tela do processo de “Reslice”. À direita, o resultado ao final do processo. 

Fonte: O Autor 

 

12. Processo de diminuição das bordas para criação da segunda casca: 

Carregue a pasta “Reslice” no ImageJ® → Process → Erode → Repetir 7x → 

Clique em “Yes” para que o processo seja feito em todas as imagens → File → 

Save As → Image Sequence → Selecionar pasta de trabalho “Reslice Erode” 

→ Tipo de Imagem: TIFF/ Start at: 1/ Digits: 3 → Save. 
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Obs: A quantidade de vezes que o processo de erosão for aplicado neste passo, 

deve ser exatamente a mesma quantidade aplicada no passo 9, descrito mais 

acima. 

 

13. Criação da segunda casca: Carregue as pastas de trabalho “Reslice” e 

“Reslice Erode” no ImageJ® → Process → Image Calculator → Defina: “Image 

1 = Reslice”, “Operation = Subtract”, “Image 2 = Reslice Erode” → marcar 

caixinha “Creat new window” → Apply → Clique em “Yes” para que o processo 

seja feito em todas as imagens → File → Save As → Image Sequence → 

Selecionar pasta de trabalho “Casca 2” → Tipo de Imagem: TIFF/ Start at: 1/ 

Digits: 3 → Save. 

14. Criação casca final: Carregue pasta “Casca 2” no ImageJ → Image → Stacks 

→ Reslice [/] → Marque as caixinhas “Rotate 90 degrees” e “Avoid 

interpolation” → Defina: “Output spacing (pixels) = 1.000”, “Start at = Top” → 

Apply → Repetir processo para fechar as bordas nos eixos X e Y. Isso criará 

uma janela nomeada como “Reslice of Reslice” na posição original, mantenha-

a aberta → Carregue a pasta de trabalho “Casca 1” junto com a janela “Reslice 

of Reslice” → Process → Image Calculator → Defina: “Image1 = Reslice of 

Reslice”, “Operation = OR”, “Image 2 = Casca 1” → Marque a caixinha “Create 

new window” → Apply → Clique em “Yes” para que o processo seja feito em 

todas as imagens → File → Save As → Image Sequence → Selecionar pasta 

de trabalho “Casca Final” → Tipo de Imagem: TIFF/ Start at: 1/ Digits: 3 → 

Save. 

Obs: A operação “OR” unirá as duas cascas, removendo qualquer buraco gerado na 

“Casca 2” e fechando todas as aberturas contidas na “Casca 1”. 

 

 

Figura 9. Captura de tela do processo de criação da casca final. 

Fonte: O Autor 
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Figura 10. Imagens renderizadas do resultado da casca final, onde é possível ver a delimitação da 
casca e do espaço interno vazio. À esquerda, a peça 1 e, à direita, a peça 2, ambas as imagens são 

referentes ao lado esquerdo anatômico. 
Fonte: O Autor 

 

Devido às características de impressão da impressora 3D, como a criação de 

suportes para garantir boa qualidade de impressão das áreas mais anguladas de 

uma peça, uma tampa foi feita separadamente para cada peça. Elas foram criadas a 

partir das sete últimas imagens de cada peça, o que corresponde a sete milímetros 

de altura de tampa. Foi criado então um encaixe entre tampa e peça. Os processos 

de criação das tampas e encaixe são descritos nos passos abaixo. Eles devem ser 

feitos para todas as peças. 

 

15. Separação das tampas: Para a tampa, separe as últimas nove imagens (192 a 

200) da pasta de trabalho “Casca Final”, que se refere a área inferior da peça, 

e coloque-as em uma pasta de trabalho destinada à tampa. Deixe uma cópia 

das imagens 192 e 193 na pasta de trabalho destinada à peça. Para as duas 

peças referentes aos pés, separe as nove primeiras imagens (1 a 9) e deixe 

uma cópia das imagens 8 e 9 na pasta destinada à peça. 

 

16. Criação dos encaixes: Carregue a imagem 192 da pasta de trabalho “Tampa” 

no software GIMP® → Com a ferramenta “Seleção contígua”, selecione a área 

da imagem → Vá em “Selecionar” → Encolher → Defina: “Encolher seleção por 

= 3 px” → OK → CTRL+I → Pressione a tecla “Delete” → Arquivo → 

Sobrescrever imagem original → Carregue essa imagem no software ImageJ® 

→ Carregue também a imagem 192 da pasta de trabalho destinada à peça → 

Process → Image Calculator → Defina: “Image1 = 192 (peça)”, “Operation = 

Subtract”, “Image 2 = 192 (tampa)” → Marque a caixinha “Create new window” 

→ Apply → Clique em “Yes” para que o processo seja feito em todas as 

imagens → File → Save As → TIFF → Selecionar pasta de trabalho “Casca 

Final/Peça” → Save. → Abra novamente a imagem 192 da tampa no GIMP® → 
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Com a ferramenta “Borracha”, apague os pixels sobressalentes de forma que 

fique apenas 1 milímetro de espessura → Arquivo → Sobrescrever imagem 

original → Abra a imagem 192 da peça no GIMP® → Com a ferramenta 

“Seleção contígua” selecione a parte interior do encaixe → Vá em “Selecionar” 

→ Aumentar → Defina: “Aumentar seleção por = 1 px” → OK → Pressione a 

tecla “Delete” → Arquivo → Sobrescrever imagem original →Repita o mesmo 

processo para a imagem 193. 

 

Obs: Para as duas peças referentes aos pés, a imagem 8 e 9 são equivalentes às 

imagens 192 e 193 das outras peças. 

   

Figura 11. Processo de criação do encaixe tipo macho para a tampa no GIMP®. 

Fonte: O Autor 

 

   

Figura 12. Processo criação encaixe tipo fêmea para a peça no GIMP®. 

Fonte: O Autor 
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Figura 13. Resultado dos encaixes da peça (à esquerda) e da tampa (à direita). 

Fonte: O Autor 

 

17. Salvando os arquivos em DICOM: Carregar pasta de trabalho “Casca 

Final/Peça” no ImageJ® → Save As → Save DICOM → Marcar a caixa de 

seleção “Exportar como Multislice” → Run → Selecionar destino → Salvar.  

 

18. Definindo as dimensões do voxel na imagem: Abrir o arquivo DICOM no 

software AMIDE® → Clique com o botão direito do mouse sobre o nome do 

arquivo → Vá em “voxel” → Defina: “X = 1”, “Y = 1” e “Z = 1” → File → Export 

Data Set → Defina “Export = Original orientation” e “Export format = DICOM 3.0 

VIA (X) MedCon” → Executar → Selecione o destino → Salvar. 

 

 

Figura 14. Captura de tela do processo de definição de voxel e salvamento no AMIDE®. 

Fonte: O Autor 

 

19. Convertendo arquivo DICOM para STL: Abra o arquivo gerado na etapa 

anterior com o programa 3DSlicer® → Na barra de ferramentas, selecione a 

opção “Segment Editor” → Na barra de tarefas à esquerda, selecione “Add” → 

Threshold → Defina: “Range = 254 a 255” → Apply. → Em “Show 3D” 

desmarque a “Surface smoothing” → Na seta ao lado, selecione “Export to 

files” → Selecione a pasta de destino → Defina: “File format = STL” → Export. 



129 

 

 

 

Figura 15. Captura de tela dos processos no 3D Slicer®. 

Fonte: O Autor 

 

 

Figura 16. Imagens de uma peça final (esquerda) e tampa (direita) com seus encaixes. 

Fonte: O Autor 

 

Após a conversão dos arquivos para STL, a peça estará pronta para 

impressão. A tampa, porém, deverá passar ainda por um novo processamento para 
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inserção de um buraco de preenchimento. Uma vez que cada peça será 

impermeabilizada e terá sua tampa colada antes do preenchimento da mesma com 

material radioativo. A opção de colar antes do preenchimento é para evitar riscos de 

vazamento e também diminuir, ao máximo, a formação de bolhas de ar. Para essa 

adição de um furo na tampa, o programa FreeCAD, de acesso aberto, é utilizado. O 

passo a passo segue abaixo e deverá ser feito para todas as peças. 

20. Criando o furo da tampa: Carregue a imagem STL da tampa no programa 

FreeCAD® → Na barra de ferramentas selecione a opção “Part” → Selecione a 

imagem e vá em “Peça” → Criar forma a partir de malha → Defina: “Tolerância 

para costura do objeto = 0,1” → Selecione a imagem resultante (a anterior 

pode ser excluída” → Peça → Converter para sólido → No modelo, crie um 

cilindro de 12,5 mm de raio e 4 mm de altura e outro cilindro de 7,5 mm de raio 

e 4 de altura. → Posicione os dois cilindros um acima do outro → Selecione os 

dois cilindros e faça a fusão dos dois para um único objeto com a ferramenta 

“Fusion”, o resultado deverá ser como o apresentado na Figura 18 → Posicione 

o objeto resultante em um ponto da tampa, onde ficará o furo. O cilindro menor 

deve estar voltado para a parte interna da tampa → Selecione a tampa e o 

cilindro e utilize a ferramenta “Cut” → Selecione a imagem da tampa com o furo 

e vá em “Ficheiro” → Exportar → Selecione a pasta destino → Salvar. 

 

Obs: Salve também o objeto utilizado para fazer o furo (Figura 18.A), para tampar a 

abertura após o preenchimento. Recomenda-se que diminua o raio dos cilindros, 

uma vez que passada a etapa de impermeabilização das peças, a área do furo pode 

diminuir devido a espessura de camada do material aplicado. 

   

Figura 17. Captura de tela dos procedimentos com a imagem no FreeCAD® descritos no item 20. 

Fonte: O Autor 
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Figura 18. Imagens das etapas de inserção de furos na tampa. A) Refere ao objeto gerado pela 
junção dos cilindros no FreeCAD®; B) Destaca o posicionamento dos objetos para realização do corte 

em uma vista da parte interna da tampa e; C) Trata-se do resultado da tampa com o furo, em uma 
vista da parte externa da tampa. 

Fonte: O Autor 

 

Após o passo número 20, as imagens estão prontas para impressão. As 

configurações de impressão devem seguir de acordo com as características próprias 

de cada impressora e filamento utilizado. É importante ressaltar a atenção à área de 

impressão da mesa da impressora 3D a ser utilizada antes de iniciar a manipulação 

das imagens. Caso as dimensões das peças aqui descritas forem consideradas 

grandes para o equipamento, sugere-se cortes adicionais além da divisão em direita 

e esquerda do Passo 1 deste documento.  

As peças e tampas precisam passar por um processo de impermeabilização 

para evitar vazamentos quando forem preenchidas. Após testes, a resina epóxi de 

alta viscosidade foi o impermeabilizante com melhor desempenho, impedindo até 

mesmo o vazamento de água. É um material altamente recomendado para esta 

finalidade.  

O resultado de uma peça e do fantoma físico completo podem ser 

visualizados na Figura 19 e Figura 20, respectivamente. 

 

A B C 
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Figura 19. Fotografias do resultado das peças em impressão 3D. A) Vista inferior da peça, 
demonstrando seu interior oco e o encaixe aplicado; B) Tampa da referida peça com encaixe e; C) 

Vista frontal da peça e tampa encaixados. 
Fonte: O Autor 

 

 

Figura 20. Fotografias do simulador físico RFPID completo. A) Em uma vista frontal; B) Vista lateral 
direita e C) Posicionado em decúbito dorsal na cama de um Sistema Contador de Corpo Inteiro. 

Fonte: O Autor 

A) 

B) 

C) 

A) B) C) 


